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Congratulations on the purchase of your Webscan barcode verifier! With this system, you can reach a new 

level of quality assurance. This manual will guide you in using your Webscan barcode verifier and in fully 

understanding the available features. In addition, it will assist you in understanding the verification results 

shown on the display and printed reports. 

All Webscan verifiers are operated by the same TruCheck™ Software, but some operating instructions will 

differ based on the particular unit that you have. This manual will point out how to operate each unit. For 

information about a specific symbology, please see the “Annex” entry for that symbology.  

 

CONTENTS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Revision 1.12 



Congratulations on the purchase of your TruCheck™ barcode verifier! With this system, you can reach a new 

level of barcode quality assurance. 

The Webscan TruCheck™ family of laser and CCD imager based barcode verifiers evaluate 1D and 2D 

barcodes and grade them according to international and industry standards established by ANSI, ISO/IEC, 

CEN, GS1 and other organizations. Detailed diagnostic information is available on screen and reports of 

verification results are produced for printout or electronic archival. 

The TruCheck™ system is as easy to use as it is powerful. The main features of the system are: 

 Accurate barcode verification according to global standards 

 CCD Imager with integrated illumination or Laser-based barcode profiler (scanner) 

 Repeatable and accurate results 

 Calibrated and traceable to NIST standards 

 Intuitive User Interface 

 Detailed reporting 

 Storage of verification results in Adobe PDF™, HTML, MS Excel, and CSV 

 Consistent results independent of operator training or skill 

This manual will guide you in using the TruCheck™ verifier and in fully understanding the available features. In 

addition, it will assist you in understanding the verification results shown on the display and printed reports. 

 

*TruCheck is a trademark of Webscan, Inc. 

 

Check the verifier package for the following items. 

 TruCheck™ Imager or Laser-based verifier unit 

 TruCheck™ Software Installation CD (can also be downloaded from Webscan's website) 

 Power Supply (if applicable) 

 Quick Set Up Sheet (if applicable) 

 One of several available Calibration Cards 

If any of the above items are missing, please contact Webscan. (Contact information can be found in the “if 

you need service” section near the end of the manual.) 

NOTE: The calibration card is usually an optional orderable item and might not be included in your package. 

However, a calibration card is required for proper operation of the TruCheck™ barcode verifier, so be sure 

that you have one before attempting to use the barcode verifier for the first time. 



 

 

TruCheck™ USB installation program takes you through the installation with instructions on every screen.  

Before installing TruCheck™ USB:  

 Close all other applications.  

 Make sure the TruCheck™ USB hardware is not plugged into the computer.  

 

NOTE: If the TruCheck™ USB hardware is plugged in before or during the software installation, the computer 

will install the TruCheck™ USB as an “unknown” device and it will not function.  

 

Log into your computer with administrator privileges if you are installing on Windows 7, 8, or Vista.  

Make sure that the .NET framework version 3.5 is installed on the PC. If the framework is not installed on the 

PC, you can do so by browsing to the “dotNET Installer” folder on the CD and running “dotNet Installer v3.5” 

executable. Make sure to use the Windows Update function to check for update information pertaining to 

the .NET framework. 

To install TruCheck USB Software: Insert the TruCheck™ USB CD-ROM into the CD-ROM drive. The 

installation program should start automatically. If it does not start, locate your CD-ROM drive in Windows 

Explorer and double-click the Setup.exe program at the top-level of the CD-ROM.  

Follow the on-screen prompts to complete the installation. 

 

The following information shows the proper setup procedures for your new TruCheck™ USB. Before 

proceeding, locate the verifier and any accessories you purchased.  

 

NOTE: The TruCheck™ USB software should already be installed in accordance with the preceding section of 

this manual before plugging in the TruCheck™ USB hardware to the computer.  

 

Please connect the power supply cable to the cable coming out of the verifier with the barrel connector. Next, 

plug the power supply into the AC outlet. 

  

Connect the USB connector directly to a USB port on the computer. The USB port on the computer must 

support USB 2.0. 

Follow the on-screen prompts to complete the hardware installation. Once the USB cable is attached to the 

computer, you should see the “Found New Hardware” dialogue. With laser verifiers, you will be prompted 

twice. Wait for the “Found new hardware, your hardware is installed and ready to use” window to pop up. 

If prompted that the driver has not passed Window’s logo testing, select “continue anyway”. 

If prompted for the location of the drivers or any other files required during installation of the hardware 

drivers, please use the following folders: the “Drivers” folder on the CD or the path “C:\Program 

Files\Webscan Inc\TruCheckUSB\Drivers”  

 



 A Windows-based PC running an Intel Core 2 or iSeries processor (i.e. Core i3, i5, i7) or equivalent. 

 2GB RAM minimum, 4 GB RAM recommended 

 Hard drive with at least 200 MB free space 

 Screen resolution 1024x768 recommended - 800x600 minimum 

 Embedded USB 2.0 (system will not work with USB 1.0, USB 1.1, or some USB 2.0 add on cards) Direct 

connection to a PC USB 2.0 ‘A’ connector is recommended, not through an external USB hub. 

 

 Windows 10, Window 8, Windows Vista, Windows 7, or Windows XP installed. It is recommended that 

the latest service pack and all critical updates for Windows XP are loaded and configured before 

installing the Webscan application. 

 Dot Net 3.5 SP1 must be installed and activated on the machine. 

 Minimize or eliminate other USB data intensive applications before running the TruCheck software. 

I.e., applications streaming USB audio or video. 

 

Software Updates are available online at www.webscaninc.com under the resources tab. Select “Software 

Update Request” and fill out the request form. You can also contact Webscan Customer Service to request 

the upgrade by e-mail at support@webscaninc.com.  

We recommend joining our mailing list or following us on Facebook or Twitter to receive update notifications. 

Email marketing@webscaninc.com to subscribe to our mailing list. 

 

http://www.facebook.com/webscaninc 

 
http://www.twitter.com/webscaninc  
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Intelligent Mail barcodes are used in the USPS mailstream to increase the efficiency of deliveries. Intelligent Mail 

barcodes combine routing ZIP code information and tracking information into a single 4-state code. It encodes data 

from POSTNET and PLANET barcodes into a single barcode while providing a greater range of tracking data. 

 

POSTNET barcodes encode a ZIP code or ZIP+4 code into half and full-height bars. Most often the delivery point is 

added, usually being the last two digits of the address or PO box number. In 2013, POSTNET barcodes were replaced 

with Intelligent Mail barcodes (IMB) by the USPS. IMB symbols encode data in 4-state bars which can be one of: tracker, 

descender, ascender, or full height bars. 

Correctly printing IMB symbols is critical for commercial mailers, as the USPS imposes penalties (in the form of higher 

postal rates, or non-approval of mail systems) for non-conforming symbols. However, it is almost impossible to know if 

an IMB system will meet USPS requirements. Webscan barcode verifiers fill this void by applying tests to IMB symbols 

according to requirements specified in USPS-B-3200. 

Support for Postnet and Intelligent Mail Barcode (IMB) is available as an optional feature in Webscan barcode verifiers. 

To enable this feature, a license file must be purchased and loaded into the verifier unit (under the Help Menu, Activate 

Feature). The license file is tied to the "Board Serial Number" found in the Help About window in the software.  

Postnet and IMB symbols are verified in accordance with 

USPS-B-3200 and Merlin* test criteria and reported with Pass 

(meets USPS requirements), Good (does not pass all USPS-B-

3200 requirements but does pass Merlin test criteria), Warning 

(does not pass all USPS-B-3200 requirements and generates a 

“Warning” message under "Merlin" test criteria), or Failure 

(does not pass all USPS-B-3200 requirements and generates a 

“Failure” message under “Merlin” test criteria).  

A visual representation of each passing and failing feature of 

the symbol is shown on the results screen and itemized in the 

report for each bar of the symbol. Bar spacing, rotation, 

minimum and maximum height, minimum and maximum width, bar continuity, pitch, clear zone reflectance, and symbol 

skew, are all graded and reported.** Also, the orientation of the symbol (forward or backward/upside down), including 

mirror image, is automatically detected and reported.   

* Merlin test criteria are not published by USPS and have been derived according to the best available information. 

** Decoding method is not specified by USPS to interpretation of bar orientation and other parameters are subject to 

Webscan’s implementation. 

Please contact support@webscaninc.com for more information and assistance in setting up your software.  
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Support for Maxicode (UPS Barcode) is available as an optional feature. To enable this feature, a license file must be 

purchased and loaded into the verifier unit (under the Help Menu, Activate Feature). The license file is tied to the "Board 

Serial Number" found in the Help About window in the software. Maxicode is verified in accordance with ISO/IEC 16023 

and ISO/IEC 15415, with some necessary modification documented by ISO/IEC JTC1/WG1 committee.  

Please contact support@webscaninc.com for more information and assistance in setting up your software.  
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Before we begin, you may need to calibrate your verifier. For more information on calibration, please refer to 

the calibration chapter. 

Notice the large “Go Live” button. When clicked, the 

camera will capture live images, which will be shown 

in the main window. This image is useful for 

positioning the imager over the bar code that you 

wish to verify. Place the imager over the symbol to 

verify.  

NOTE: The "Start" button on the imager will do the 

same thing as clicking the “Go Live” button.  

If more than one code is in the field of view, you can 

draw a box around the code you want to verify. For 

more information, please see . 

NOTE: Holding the imager with your right index 

finger on the “Start” button and the cable away from 

you will make it easier to aim the verifier and position 

it over the symbol to verify. 

You will notice that the “Go Live” button now says 

“Verify”. When the bar code is positioned correctly, 

click on that button again to begin the verification.  

After successful verification, you should see a similar 

screen. The main screen features a static image of the 

symbol verified. The center portion contains the 

overall grade and barcode type. The quality 

parameters are listed to the right. Below the main 

screen is a box showing the encoded data. 

Depending on the symbology and grading standard, 

more or different detail will be displayed. The tool bar 

buttons and tabs are useful for in-depth analysis of 

barcodes and will be explained later in the

Results section. 



Specifying regions in the live image may be required for the following reasons: 

 Multiple codes in the field of view 

 Defining a section of a linear code 

 In multi-mode, identifying the regions in a particular label format to be verified 

 If the code is off center 

 Speed up the verification process on verifiers with large fields of view; defining a small sampling area 

will increase the speed.  

In order to define a region, position your cursor where you want the region to start, hold the left mouse 

button down and begin drawing a box by moving the mouse. Release the button when you are done.  

NOTE: When defining a region on 1D linear code draw your region within the symbol. If the region extends 

outside of the code, the verifier will attempt to scan that region, resulting in un-decoded scans. In the 1D 

settings menu, you may optionally select linear auto detect and the selected region can extend beyond the 

code without affecting the grade.  

For 2D matrix symbols and linear stacked symbols, the region should be drawn surrounding the entire code. 

The verifier will need the entire finder pattern, including quiet zones, within the selection to properly grade 

the code.  

 



 

We’ll use a UPC-A symbol as an example when verifying linear barcodes.  

Press the large “Go Live” button on your user interface or the start button on your verifier, whichever you 

prefer. When “Live”, you will see an image on the display. Position the red target shown on the main screen in 

the center or close to the code. 

 

In this example, a UPC code is placed in the field of 

view with a camera-based verifier.  

 

A region will need to be drawn around the UPC code. 

 

Next, hit the large grey “Verify” button. 

 

This image represents a successfully graded 1D 

barcode.  

 

 

 

 

NOTE: 

  On both camera and laser-based hand-held verifiers, positioning is made easier if the cable is facing 

away from the user.  

 When using a camera-based verifier with a large field of view like an Omni or Tower, users may want 

to define regions as explained in . 

 The tool bar buttons and tabs are useful for in-depth analysis of barcodes and will be explained later 

in the  section.  

 

 



This section refers to 2D Matrix symbologies such as Aztec, Data Matrix, QR, and optionally Maxicode and 

Postnet codes.  

*If you want to see information pertaining 

to a particular type of symbol, refer to the 

“Annex” chapter and find the section on that 

symbol.  

To verify a 2D symbol, first click on the 

“Main” tab. Once there you should see the 

“Go Live” button again. Click on it and 

center your symbol in the screen.  

Once you have selected “Go Live”, a red 

cross indicating a target will appear. Please 

try to place the symbol you wish to verify 

as close to that target as possible.  

NOTE: 

 If multiple codes are present, you 

will need to draw a region around 

the desired symbol.  

 The region must be drawn around 

the outside perimeter of the code 

including quiet zones. More 

information on properly defining 

regions is explained in 

 on page 11. 

Once you have made your region selection 

(if required), hit the “Verify” button or press 

the “Start” button on the verifier to begin 

verification. 

This screen shot is representative of a 

successful 2D barcode verification. 

Depending on grading and application 

standards, additional detail will be 

displayed. 

NOTE: The tool bar buttons and tabs shown on the screen are useful for in-depth analysis of barcodes and 

will be explained next in the Results section.  



 

In this section, we will review the software tools provided that would aid you in analyzing your verified 

barcodes. 

Click on the “Data Detail” tab  

When viewing this tab, all of the data content 

of the symbol is shown. Detail depends on 

symbology and application standards selected.  

For example, the first screen shows a 1D code 

with the GS1 data parsing selected. The second 

screen shows a 2D Data Matrix with encoding 

information.  

Click on the “General Characteristics” tab.  

This section will show you physical 

characteristics of the barcode you verified.  

For example, the first screen shows characteristics of a 

1D UPC barcode.  

The second screen shows characteristics pertaining to 

a 2D Data Matrix barcode. The "Contrast Uniformity" 

value, which is important for verifying conformance 

with ISO/IEC 15426-2 is also shown in this section. 



Click on the “Quality Detail”  tab.  

The measured quality parameters are shown in this section. The formal grade is listed here. Linear barcodes 

graded according to ANSI/ISO will have each individual scan shown. Different symbologies and quality 

grading standards will display pertinent data here.  

For example, the left screen below shows characteristics of a 1D UPC barcode. The second screen on the right 

shows characteristics pertaining to a 2D Data Matrix barcode graded according to ISO 15 415. Detailed 

explanation on the grading standards can be found in 

. 

Click on the “Advanced Detail”  tab.  

The “Advanced Detail”  tab shows in-depth information and 

the particular info shown is dependent upon the type of 

barcode. In this case, we see the element widths of the UPC 

symbol in the first example. At the top are the individual bar 

and space sizes. The table on the left shows the element 

width deviation from ideal size. The below example shows the 

modulation values from a Data Matrix symbol.  

Detailed explanation on modulation calculation can be found 

in the 

under the ISO 15 415 and AIM-DPM grading 

explanations. 



 

Click on the “SRP” tab. This tab will be present with verifying 1D and stacked barcodes.  

 

SRP stands for Scan Reflectance Profile. The SRP is what the grade is derived from. In this tab, you can 

examine every scan’s SRP. The round green arrow up and down buttons will move you through the scan. The 

nine graded results for each scan are listed under “Scan Properties”, as well as the overall scan grade. The 

image of the barcode may be magnified to examine sections of the code, much like a microscope would do.  

The “Original Scan” section is representative of the test aperture size as seen by the camera or laser. The 

“Nominal Modules” are representative of a perfectly printed code. The “Thresholded Edges” section shows the 

elements as detected by the verification algorithm.  You can see printing discrepancy when these widths do 

not agree with the Nominal Modules.  If you hover over the thresholded elements with your curser, a tooltip 

will display the edges and modulation defect and decodability grades (for most symbologies). Edge shifts that 

result in the lowest decodability for the element are highlighted when you hover over the element. 

The scan reflectance profile graph represents the light and dark thresholds with a global threshold. The graph 

is color-coded to indicate the grade throughout the code. This section can be magnified as well by using the 

magnification buttons or by drawing a box around the area, you wish to see closer. The zoom feature will 

allow you to see defects or other discrepancies that may be present.  

NOTE: The ability to see the entire image is only available when using a camera verifier. When using a laser 

verifier, users will only see one scan section at a time.  



Click on the “Histogram”  tab. This tab will be present when verifying 2D matrix symbols.  

 

The “Histogram” tab will show analysis of each cell’s reflective and associated grade.  

The horizontal axis on the histogram represents the brightness level, with the dark elements on the left and 

the bright elements on the right. The brighter the element is, the further to the right it will be. The height of 

each bar represents the number of elements with the brightness associated with its position on the horizontal 

axis. 

The top graph is a histogram representing the brightness of all the pixels in the image. The bottom graph 

only represents the center of modules in the symbol. As expected, the bottom graph does not contain 

elements which are not either definitively dark or definitively bright. While all the dark or bright modules are 

not exactly the same in brightness, they are relatively close to each other and that is why the bars are 

grouped together. In the upper histogram, some pixels, which are in between dark and bright, are 

represented. These pixels are typically on the border between dark and light modules and thereby obtain a 

middle value of brightness. 

The horizontal axis contains markers showing the global threshold (tall line) and the separation between B 

and C, and between C and D modulation levels for both dark and light elements. 



 

Click on the “Report” tab.  

 

A preview of the report is shown. The contents of the report can be customized to include more or less detail. 

Customization can be done in both the 1D and 2D settings menus, as well as setting options for electronically 

saving reports and how they are named. This report can be printed and/or saved electronically.  

 

NOTE: Adobe PDF™ Reader is required in order to view the report in the “Report” tab. 

 

 



Before we begin, you may need to calibrate your verifier. For more information on calibration, please refer to 

calibration chapter. 

A laser-based verifier will be used to verify linear one dimensional and stacked barcodes. Stacked barcodes 

include GS1 data bar (formally RSS) and PDF-417 symbologies.  

Place the verifier over the symbol so that the symbol to 

be verified is centered and level in the opening of the 

guide plate. 

NOTE: It is very important that the barcode is centered 

in the guide plate opening. The pointed indicators in 

the guide plate serve as a guide for locating the symbol 

in the center. 

The laser-based verifier automatically moves the laser 

from its "Start" position to its "End" position when you 

verify a symbol. The start and end 

positions are indicated on the screen by 

the two red lines. The distance between 

the red lines is also shown on the 

screen.  By pressing the “Start” button 

on your verifier, you will see the laser 

beam. Place the laser beam on the top 

of the barcode. Next, refer to your 

screen. 

You can adjust the “Start” and “End” 

positions by clicking and dragging them 

with your mouse. You can also use the 

green buttons that are located to the 

right of the main image. To use these 

buttons, click on the buttons "Begin" or 

"End" and then use the “Up” and “Down” 

arrows to move the red lines. The laser 

moves according to your commands 

and you can adjust the “Begin” and 

“End” positions to cover the size of the 

barcode that you intend to verify. 

When you press “Verify”, the laser will 

move though the barcode and an image 

will be displayed on the main screen 



 

that shows the reflected light detected by the laser verifier. This image may be more "jagged" than an image 

from a digital camera, but this is normal for a laser scanner and will not affect the accuracy of your verification 

results.  

After successful verification, you should see a similar screen. The main screen features a static image of the 

symbol verified. The center portion contains the overall grade and barcode type. The quality parameters are 

listed to the right. Below the main screen is a box showing the encoded data. Depending on the symbology 

and grading standard, more or different detail will be displayed. 

The tool bar buttons and tabs are useful for in-depth analysis of barcodes and will be explained later in the 

 section.  

NOTE:  

 When adjusting the laser sweep or start/end position, linear 1D barcodes should start inside and end 

inside the barcode. Stacked symbols: the laser sweep should start outside the top and end outside the 

bottom of the barcode (or user Linear Auto Detect, see below).  

 If the region starts above or below a 1D barcode, the verifier will attempt to scan that region, resulting 

in un-decoded scans. In the 1D settings menu, you may optionally select linear auto detect and the 

selected region can extend beyond the code without affecting the grade.  

 On the top of the user interface you will see numeric buttons ranging from 1 to 6. These buttons can 

be used to save commonly used laser sweep settings. To save a setting, simply hold the ctrl button 

and click one of the buttons. Now that sweep setting can be recalled.  

 The laser will go to sleep after 4 minutes. You may notice that the “Verify Code” button now says 

“Resume” when the laser is asleep. You can wake your laser up by pressing the start button on the 

laser or clicking the “Resume” button on your screen.  

 

After verifying with a laser-based verifier, the results are presented in the same tabs and shown above for 1D 

symbols with an imager-based verifier. 

 



o Switch to Multi Mode– Restarts the User Interface in Multi-Mode, a feature that facilitates 

simultaneous verification of many barcodes within the same image. (Note: when in Multi-mode, this 

menu choice is replaced with "Switch to Single-Mode". See chapter for more 

information about Multi-Mode. 

o Print Report – Allows the operator to select any printer in the Windows Printer Folder for printed 

reports. 

o Print Strip Report – Prints a report formatted 

to 40 columns to be printed to an attached 

thermal or dot matrix printer. 

o User Password Options – Allows the System 

Administrator to set Password Protection on 

the “Settings” and “Calibration” menus and 

“Lighting Option” toolbar buttons. In order to 

change the password, you need to enter the 

current password. The default password as 

shipped from Webscan is “user” (using lower 

case letters). 

o Exit – Close the program. 

o Settings – Sets up the system for symbology, quality standards selection, and reporting options. 

This menu can also be accessed by clicking either the 1D or 2D Toolbar buttons. 

o User Settings – Sets up several items that can be 

included in your reports, such as company name, 

product name, operator name, job number, batch 

number, and company logo. 

o Advanced Settings – These settings are password 

protected; these settings should only be accessed 

when instructed by a technical support 

representative from Webscan. 

o Calibrate Remote – This is the Calibration menu; 

detailed calibration instructions appear later in this 

manual. 



 

o Activate Feature – This is a method for loading a 

license file that activates a special or optional 

feature of the software. 

o Calibration Log – A complete log of date and time 

the verifier has been calibrated. 

o Revision Log – A list of software feature additions 

and bug fixes, organized by software version. These 

can be selected and printed. 

o Debug Information –  

 Save Now - Used to save a file of problematic codes for evaluation by Webscan. Select 

this option after the scan and save the file to a known location. This file can be emailed 

to Webscan for evaluation. 

 Save Before Verify – Used to save a file of problematic codes for evaluation by Webscan 

in cases where the verification process causes the software to crash or otherwise 

prevents the saving debug information after the scan has taken place.  

o About – Lists the current software revision. 

o Update – If the PC that the verifier is connected to has internet access, this option will initiate a 

check of more current software and download the software to the machine for installation. Details 

for upgrading software are in section  of this manual. To find out what the most 

current version of software is, please visit www.webscaninc.com and review the FAQ section.  

http://www.webscaninc.com/


 

Illumination Icons  

 

These icons only pertain to the TruCheck™ 2D USB-DPM imagers and the TruCheck™ DPM Tower.  For more 

information, please refer to the Using a TruCheck 2D USB DPM and TruCheck DPM Tower Verifier  section. 

Diagnostic Icons:  

The Magnifier Icon – The Magnifier enhances or enlarges the view of a decoded symbol. This is 

beneficial for examining problem areas of a symbol. After you verify a symbol, the default view is 

magnified. Clicking this icon will zoom out to the actual image size. If you click the image again, it 

will zoom back in.  

 

NOTE: You can also draw a section in the zoomed in image for additional magnification. Right clicking with 

your mouse will return the view to the actual image size. 

 

The Grid Icon – This either removes or overlays the barcode with a grid. In the case of 2D symbols, 

the grid displays the intersections and apertures, yellow or red indicators, representing warning or 

failing sections of the barcode. There are options on the grid to view the real grid, the ideal grid, 

have mod circles filled, or mod circles with no fill. The circles represent the test aperture size and if shown in 

green, they indicate an “A” or “B” graded area. Yellow circles indicate a “C” level graded area and red circles 

indicate a failing region.  

 

The Original Icon – This restores the original view of the barcode.  

 

The Black and White Icon – This will display the image as an imager might see the barcode. The 

black and white image is the result of thresholding the blurred image with the global threshold. 

The black and white image is what is actually used for decoding.  

 

The Blurred Image Icon – The blurred image represents the result of processing the original image 

with the verification aperture. Small defects such as spots and voids may be “filled in” by this 

processing and edges will appear to be “softened”. This image is then used to calculate the global 

threshold, which is applied to the blurred image to get the black and white image.  

 

The Excel Icon – Included with the TruCheck software is a feature where verification results can be 

captured into a Microsoft Excel™ Spread Sheet. Excel™ files can be saved on the local hard drive or 

any network path where the user has permission to write data to. 

The Excel option can be initiated by clicking on the Excel Icon displayed on the interface or by selecting it from 

the “Options” menu -> “Save results to Excel”. The spreadsheet will open and can then be minimized to run in 

the background. All subsequent verifications will be posted to the sheet. The sheet should be saved as a different 

name (job, date, etc.) so that the template remains a blank sheet.  

The Print Icon – This icon will print the results of the last barcode verified to the Default Windows 

Printer. 



 

 

DPM (Direct Part Mark) verifiers have multiple lighting options to grade according to various grading 

methodologies and standards (such as AIM DPM). 

 

Depending on the model that you have, the Lighting buttons on the toolbar will be available to quickly select 

the lighting option of your choice. The available lighting options may be affected by your application settings. 

 

 
 

NOTE: Some lighting options are not allowed in some application standards so you should only select options 

that provide you with a result that is valid or your application. It is common to use AIM DPM as the basis for 

grading when working with DPM symbols and lighting other than 45 degree light from four sides. 

 

Illumination Icons  

 

45Q Icon – This icon selects 45-degree illumination. 45-degree four-sided illumination is used 

primarily for labels and is the only option with the standard USB and Wide Angle imagers. This is 

the illumination needed for linear 1D and 2D barcode verification. This illumination is either not 

reported or is reported as 45Q. (If illumination is not reported, it is assumed to be 45Q)  

 

30Q Icon – This icon selects 30-degree illumination from four sides. It may reduce glare from some 

substrates, which cause poor Symbol Contrast or Modulation grading. This illumination is reported 

as 30Q.  

 

30T Icons – These icons select 30-degree two-sided illumination. These are again for substrates 

causing issues with the 45Q illumination or on curved surfaces. This illumination can be from either 

the North/South or East/West. This illumination is reported as 30T.  

90 Icon – This icon selects 90-degree diffuse illumination and works well on very shiny substrates 

and Dot Peen Applications. It is reported as 90. 

The Illumination Icons are quick shortcuts to select the 

most common lighting choices. The Lighting menu, 

under Options, shown here, provides a way to select 

even more options (if available on your verifier model) 

and to choose a sequence of multiple lighting options 

to be used automatically when verifying. 

Select each of the lighting options that you would like 

to use during verification, and then select your cycling 

option. When verifying, the system will proceed to 

verify, repeatedly using each selected light (Cycle All) or 

until one of the lighting options results in a passing grade. 



 

The DPM Tower allows the height of the imager 

to be adjusted to facilitate verification of 

barcode symbols that can be on parts of 

various size and thickness. When a part is 

placed under the imager, the height of the 

imager can be adjusted by turning the handle 

at the top. Turning the handle in one direction 

raises the imager and turning it in the opposite 

direction lowers it. 

 

When you select “Go Live”, if the imager is not 

at the correct distance over the target, the 

software will automatically go into focusing 

mode. In the focusing mode, you will see a 

target circle and a spot of light.  

 

The spot of light is the image of a light source 

that is projected down from the imager. By 

moving the imager up and down you place the 

spot of light into the target circle. When the 

spot of light is in the target circle, the circle will 

turn green, indicating the correct focal distance.  

 

Now when you press “Go Live”, the focusing 

light will be turned off and a live image will be 

shown. Whenever you initiate a verification, the 

focus will be checked again, and if not in focus, 

the software will automatically go into the 

focusing mode. 

 

 

 

 



 

 

Your TruCheck™ verifier is a precision optical electronic instrument. Periodic calibration is necessary to 

account for changes in the environment. Ambient light and temperature are typical environmental conditions 

that frequently change. Electrical components also drift (change characteristics) over time and this can affect 

the accuracy of measurements made by the TruCheck™ verifier. Webscan recommends that you calibrate on 

a monthly basis; this is set as the default calibration reminder.  

Please locate your calibration card for the next steps in this process. Calibration cards do not come standard 

with verifiers. In most cases, your sales representative should have explained the different card options and 

one should be included in your packaging.   

NOTE: Calibration cards have an expiration date listed on the card. It is very important to only calibrate your 

unit with a valid card. When working with a verifier that can handle 2D codes, you can calibrate with either a 

1D or a 2D calibration card.   

If you would like to order a calibration card for your unit, please contact support@webscaninc.com or call 

303.485.6811.  

Part Number Description Verifier models 

4899 3MIL Calibration and Conformance 

Symbol (UPC/EAN) 

3mil lasers 

1556 6MIL Calibration and Conformance 

Symbol (UPC/EAN) 

6mil Lasers 

2633 10MIL (GS1/UCC/EAN-128) Calibration 

and Conformance Symbol 

10mil Lasers 

2222 20MIL Calibration and Conformance 

Symbol (ITF-14) 

20 mil Lasers 

4744 GS1 Data Matrix Calibration and 

Conformance Symbol 

All Camera Based verifiers 

5136 Webscan Calibration Symbol All Cameras and 6mil lasers 
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1.  When calibrating with GS1 standards, locate your copy of the “Calibrated Conformance Standard” sheet 

that was included with your calibration target. This sheet contains the Rmin and Rmax values you will log into 

the software prior to calibrating. If using the Webscan Calibration card, the Rmin/Rmax values are logged 

directly on the card. 

2.   Click “Go Live” and position the calibration symbol 

under the guide plate as shown in the image below. 

Set the laser sweep so that the laser is within the code 

beginning to end. 

 

3.   Select “Options → Calibrate Remote” from the 

main menu.  

4.   Enter the Rmax and Rmin values in the respective 

textboxes. These values can be found by using the 

chart on page 1 of your “Calibration Conformance 

Standard-ANSI Print Quality Analysis”  

 sheet. On the Webscan calibration card, these are 

logged below the UPC symbol. 

 

5.   You may log in a calibration interval reminder at 

this time if desired. 

6.   Click on “Calibrate”. The system is now being calibrated; this may take a few seconds.  

 

NOTE: The report included with the calibration barcode gives all the values in tenths. i.e. 69 would be 

considered a 6.9. The TruCheck accepts whole numbers only so you must round this value to the nearest 

integer.  For the previous example of 6.9, you would enter 7. Likewise, the value 824 represents 82.4 so you 

would enter 82. Once the Rmin and Rmax values are entered during the initial calibration, they will be stored 

in the system for future use.  

 

7.    At the end of the calibration process, the TruCheck™ USB calibration screen will show, “Successfully set 

Rmax and Rmin”.  

8.    Check that the calibration settings are within range by verifying the calibrated symbol and confirming the 

results. Results are displayed in the “Quality Parameters”  tab on the User Interface. Beside the SC (Symbol 

Contrast) grade, RL/ RD (Reflectance Light element/ Reflectance Dark element) values are displayed and 

should be equivalent or within tolerance to the Rmax /Rmin values logged in at calibration. Tolerance is 

referenced in the Annex –Engineering Specs.  

 

DPM NOTE: When checking conformance with a calibration card that is calibrated to ISO 15415 using 45 

degree light from 4 sides, it is necessary to select the 45Q lighting option, and set the aperture at Auto 80% 

on your DPM verifier in order to get conforming results.  



 

 

1.   Note the Rmin/Rmax values logged on your calibration card. If using a linear one-dimensional calibration 

symbol on a GS1 calibration and conformance symbol, locate the “Calibrated Conformance Standard” sheet 

that was included with your calibration target. 

2.   Click “Go Live” and position the calibration Master Symbol as close to the red target in the live image as 

possible. 

3.    Select “Options → Calibrate Remote” from the 

main menu.  

4.    Select the bullet appropriate to the type symbol 

your “Calibration Symbol” represents: Data Matrix or 

Linear. 

5.     Enter the Rmax and Rmin values in the respective 

textboxes. These values can be found by using the 

chart on page 1 of your “Calibration Conformance 

Standard-ANSI Print Quality Analysis” sheet GS1 Linear 

Calibrated Conformance symbols. On the GS1 Data 

Matrix Calibrated Conformance standard and on the 

Webscan calibration card, these are logged directly on 

the card.  

6.    You may log in a calibration interval reminder at 

this time if desired. 

7.    Click on “Calibrate”.  The system is now being calibrated; this may take a few seconds.  

 

NOTE: The report included with the calibration barcode gives all the values in tenths. i.e. 69 represents the 

number 6.9. The TruCheck™ accepts whole numbers only so you must round this value to the nearest integer.  

For the previous example of 6.9, you would enter 7. Likewise, the value 824 represents 82.4, so you would 

enter 82. Once the Rmin and Rmax values are entered during the initial calibration, they will be stored in the 

system for future use.  

 

8.    At the end of the calibration process, the TruCheck™ USB calibration screen will show, “Successfully set 

Rmax and Rmin and Pixels/Mil”.  

9.    Check that the calibration settings are within range by verifying the calibrated symbol and confirming the 

results. Results are displayed in the “Quality Details” tab on the User Interface. Beside the SC (Symbol 

Contrast) grade, RL/ RD (Reflectance Light element/ Reflectance Dark element) values are displayed and 

should be equivalent or within tolerance to the Rmax /Rmin values logged in at calibration. Tolerance is 

referenced in the Annex –Engineering Specs.  

 

 

 

 



 

This is an example of the 1D settings screen. 

You can access this screen from the options 

menu in the upper left hand corner of the 

interface.  

 

Alternately, you can simply click the 1D button 

(depicted below) also located in the upper left 

hand corner of the interface.  

 
 

 

Select the appropriate box for the type of symbol you are 

verifying. For best results, deselect all boxes for code types 

you are not verifying. Common 1D linear symbols are 

automatically selected.  

 

SETTINGS SPECIFIC TO GS1 DATABAR: 

GS1 DataBar can report as the legacy name ‘RSS’ or the current designation ‘GS1 DataBar’. 

The symbology specification changed in 2011, so your verifier will grade according to the new rule or legacy 

rule.  

 

Application Specification Acceptance Criteria 



 

 

GS1- Turns on the 

acceptance criteria 

defined by GS1, 

including minimum 

grade, detailed 

parsing of the GS1 

data strings and 

minimum X Dimension/Magnification.  When GS1 is activated by clicking its radio button, the selections are: 

Always – to always check, and Auto – to check only when a GS1 Symbology is decoded (but not fail a Code 

128 symbol which does not contain a leading Function 1 character). When a non-GS1 symbology is decoded, 

the pass grade rule will be applied instead. Note: you can select GS1 Format Check without selecting GS1 

Application standard (select Pass Grade instead) if you want to check data format but not other rules, such as 

minimum Magnification or minimum pass grade. (UPC/EAN Symbols will be checked for Magnification and a 

warning will be issued when Magnification is less than 80% but more than 75%. A failure of GS1 Acceptance 

criteria will be issued when Magnification is less than 75%. If you do not want to be warned or receive a 

failure when violating these magnification minimums you should set your Application to Pass Grade, not GS1). 

 

Pass Grade- Establishes the minimum acceptable grade for the user’s application. When activated, this 

displays a new field on the main screen that not only displays the grade, but turns red if the grade received is 

lower than the minimum set, and green if the grade is higher. This is useful for providing an at-a-glance 

acceptance or failure. 

 

UDI/HIBC – This application standard checks symbols that meet UDI requirements using either GS1 or HIBCC 

guidelines. 

Format Check ISO/IEC 15434 – This application standard checks data for many industry standards which 

encode information using ISO/IEC 15434 data structures. Typical applications using this data structure include 

parcel shipping and other material handling applications using PDF417 or other high capacity barcode 

formats. 

 

Laser Emulation – This is a special feature to make imager based verifiers perform in a similar way to Laser 

based verifiers.  

 

 

 

 

 

 

# Scans- Default value is 10 scans, but it is adjustable from 1 to 100. This is the number of scans that will be 

analyzed and graded. 

 

Aperture- This is the synthetic aperture size the system will use to process the raw image into the reference 

(blurred) image. The aperture can be selected with the drop down box or manually entered by typing an 

aperture size in ten thousandths of an inch. For example, a 6-mil aperture is set either by selecting it from the 

drop down by typing 60. 

 



NOTE: 6mil aperture is required for verifying many linear barcodes, such as GS1 –DataBar (RSS), so when 

Linear/RSS is selected, the aperture will default to 6mil. The correct aperture size to choose is always 

governed by an application standard.  

 

Wavelength- This setting cannot be adjusted. This is the wavelength of the light used to verify the symbol.  

 

I25/ITF14- When evaluating per ANSI/ISO I25 standard or GS1 ITF14, you must select “Standard I25” to 

evaluate per the GS1 criteria.  

 

UPC Sup- Used to evaluate UPC Supplemental symbol extensions. Options include none (default), Auto, 2-

digit, and 5-digit. Choose “Auto” to let the software detect when a supplement exists.  

 

Mode- This option is used to verify barcodes that are either inverted (white on black) or pre-press (such as 

film). Options are Normal, Pre-Press Negative, Pre-Press Positive, or Inverted Image.  

 

Linear Auto Detect- This option allows the user to create test areas larger than the code or no test area 

selection at all. The process will find the decodable area and divide the scans evenly throughout the code. 

Symbol height is reported in the event only a small area of a poorly printed code is decodable. This option 

can be deselected if the user wants precise diagnostics of poorly printed symbols.  

 

Ladder Orientation- Option for verification of linear codes aligned in the field of view in a ladder orientation, 

where the code’s bars are oriented left to right.  

 

MSI Plessy Decode Options 

 

Mode- Mode can be set to 1 or 2 and controls the check digit calculation so that it can match either of two 

ways of calculating the check digit in various MSI/Plessey applications. The mode selects which characters 

(even or odd) are weighted by 1 or 2 in the check digit calculation. 

 

Truncate Check Digit- When selected, the last digit (which is a check digit) will not be shown as part of the 

decoded data. This is done to make the printed data appear to match the human readable information in 

applications in which the check digit is not shown in the human readable data. 

 

Detail that will be included in Archived or Printed reports 

 

Quality Parameters- The nine ANSI grades can be listed 

for each scan.  

 

Per Scan Results- Includes a table of values for each of 

the individual scans.  

 

Element Width- Prints the Bar Space width. Measured 

widths and deviations of the bar space combinations that make up each character encoded.  

 

SRP- Prints a scan reflectance profile on the report. 

 

Traditional Parameters- Turns on the reporting of traditional parameter values on the PDF report. Traditional 

parameter will appear in the other reports and in the user interface regardless of this option when they apply. 



 

 

Codewords- Reports on the codewords for PDF-417, MPDF, CC-A, CC-B, and CC-C symbols. 

 

Image of Symbol- Includes an image of the symbol on the report. 

 

ECC Details- Report will include information about the error correction process. 

 



 

This is an example of the 2D settings 

screen. You can access this screen from 

the options menu in the upper left 

hand corner of the interface.  

 

Alternatively, you can simply click the 

2D button (depicted below) also 

located in the upper left hand corner of 

the interface.  

 

One or more symbologies can be selected, but it is 

recommended for speed that only the symbologies used in 

the desired application be selected.  

Aperture Size- This is the sampling size used to test the 

reflectance values of individual elements within the code or 

finder pattern, and can be selected or entered manually. 

‘Auto Aperture’ uses what would be appropriate for the application specification and/or code size  

– Auto 80% uses a test aperture 80 percent of the size of the barcode’s X dimension.  

Aperture size has an effect on the grade. Bigger apertures will see bar width growth as being detrimental, 

smaller apertures may be negatively impacted by defects. Aperture size can be called out in the application 

specification, quality specification, or both.  

 



 

 

Application standards configure the verifier to grade according to an individual entity’s rules for what criteria 

is to be used to grade the codes and whether or not the encoded data meets the data formats for the 

application. 2D application standards currently implemented are the GS1 rules and the US DOD UID mandate.  

GS1- Selection will auto select the correct test aperture if selected as ‘Auto Aperture’ and will require the data 

format to meet the rules as well as a quality grade of ‘C’ or better. 

GS1-Auto- When the code has a Function 1 character encoded as the first character, the code will be graded 

according to what is spelled out in the ‘GS1 General Specification’. Codes not encoded with the Function 1 

character will not grade according to GS1 rules.  

GS1-Always- Would require the code be GS1 formatted in order to get a passing grade. Codes not encoded 

with the Function 1 character will fail. 

MIL-130-STD UID- This application standard will properly report the quality standard used to grade the code 

and data structure used when unique identifiers are created. The Military Standard spells out what standard 

grades are acceptable and users are reminded when a selection doesn’t meet the revision level or where data 

is not properly formatted.  

Pass Grade- Users may simply want to select a minimum passing grade based on a certain letter on numerical 

grade value. (A-F or 0.0-4.0) 

UDI/HIBC – This application standard checks symbols that meet UDI requirements using either GS1 or HIBCC 

guidelines. 

Format Check ISO/IEC 15434 – This application standard checks data for many industry standards which 

encode information using ISO/IEC 15434 data structures.  

 

 

 

Dot Peen- Use this option for barcodes created with the dot peening process, which is a process where dots 

are peened onto a metal surface. This helps connect the dots in the decode process. 



Invert Image- For images printed white on black. 

 X-Dimension Range- Utilized with the AIM-DPM quality standard to define the range of X dimensions used 

to decode a symbol, also used as stick size range when utilizing the DOT PEEN option.  

Avg Angles- Are used when the now obsolete version of ISO-15415 is used to verify Data Matrix. Angles are 

created on the user interface to assist in the alignment of the code where the grade was based on an average 

of five different scans at different angles.  

 The options below only pertain to QR Code. 

ISO-18004 Compliant- Verifies QR code in strict adherence to the ISO-18004 specification 

Adjust for Substrates- Uses a one module quiet zone to threshold the light space elements. This is beneficial 

for QR Codes printed on films or plastic where the internal spaces cannot achieve the reflectance levels of a 

four module quiet zone. This helps a printer determine print quality without modulation degradation due to 

substrate.  

Mobile QR (Reduced QZ) – Only one module quiet zone is tested. Printers can check print quality ignoring 

artwork that interferes with the 4 module quiet zone specified in ISO-18004.  

 Override acceptance criteria to Warn or Fail when the 

grade is close to boundary conditions. This is a Webscan proprietary measurement, 

based on calculations that predict whether slight variations in the image, could 

produce a large change in the "grid" of module centers which could potentially 

change the overall grade of a data matrix symbol. 

These are the selections that determine what Quality Standards and optional sections will print on the reports. 

  

 

 

 

Traditional Parameters- Includes Minimum Reflectance Difference (MRD) in the reported General 

Characteristics both in the verification report and on the user interface. MRD quantifies the minimum 

difference anywhere across the barcode. These worst-case black and white modules need not be adjacent to 

one another.  

Image of Symbol- Puts the image used for verification on the verification report.  

ASCII Values- Turns on the reporting of the encoded ASCII values. Values are reported on the verification 

reports as well as in the “Data Detail” tab.  



 

ISO-15415- Reports and displays in accordance with the International Standards Organization Barcode Quality 

test specification for two-dimensional symbols. Selecting this standard allows for the selection of ISO 15415 

reporting options: 

AIM-DPM- Select this if you want to utilize the AIM-DPM verification standard. This can be selected with or 

without the Dot Peen selection. 

AS-9132- Reports and displays in accordance with the SAE AS9132 quality requirement standard for part 

marking Data Matrix code. This option is only selectable when Data Matrix is chosen in the Symbologies.  

Cell Size Diagnostics- Enables reporting detailed clock track information showing heights and width for Data 

Matrix clock track elements. 

AIM:ISO (ISO 16022:2000) – Reports and Displays in accordance with the ISO-16022 Symbology and Quality 

Specification for Data Matrix code. See Table 3.1 for information pertaining to this standard. This option is 

only selectable when Data Matrix is chosen in the Symbologies.  

All other reporting options are organized by grading standard. The following reporting options have the same 

meaning regardless of under which standard they appear:  

Quality Parameters – Enables reporting of a standard’s quality parameters and their corresponding values 

and grades. Selecting this is highly recommended, as this information makes visible the reasons for poor 

results in a standard.  

Mod Values – Reports show the individual modulation values from each data cell in the symbol. Modulation 

values can be viewed on the User Interface “Advanced”  tab regardless of this selection. (See also:"Contrast 

Uniformity" on page  

Codewords – Turns on reporting of the codewords when verifying symbols. Values are reported on printed 

and saved reports as well as in the “Data Detail” tab.  

ECC Details – Turns on reporting of error correction details, which appear within the “General Characteristics” 

tab.  

Suppress on Fail – In verification, if the symbol fails (grades below the pass grade of) the standard, and it 

passes another selected standard, and then this standard’s results will not be included on the verification 

report. For example, if this option is set in the ISO 15415 standard options and both the ISO 15415 and AIM-

DPM standards are enabled, and the ISO 15415 grade for the verification is below the pass grade while the 

AIM-DPM grade is at or above the pass grade, then the ISO 15415 standard results will not appear on the 

verification report.  

 

 

 

 



 

When “Save Report” is selected, the type of reports that will be saved are 

these selections. One or more must be selected when Save is on.  

If a strip report is desired, the option for Thermal, Dot Matrix and Generic 

can be selected. The Thermal and Dot Matrix options support the Star 

character print set. 

 

 

Auto Print Report— This option will trigger a report be printed to the ‘Default Windows Printer’ every time a 

code is verified. 

Auto Print Strip Report– Same as above but the report is printed to a Windows installed Strip Printer. 

Auto Print Summary— In Multi-Mode, where summary reports are created, they can be automatically printed 

for each verify.  

Auto Prompt for Excel— If Excel functionality is required and no template is open, this will prompt the user to 

open a sheet.  

CSV Scan Details— This option will populate the Excel sheet with all 10 scans or “# scans” from the “1D Setting 

Menu”. The default is one line in the Excel sheet for each verify.  

Save Report— This option saves reports electronically to the path defined next to it. The path can be a local 

hard drive or file server the user has permission to write to. Several settings define what the reports contain 

and what formats to save.  

Append PDF— This option is used if multiple reports are to be saved in one Adobe PDF file. Enter the file 

location and name, and as long as this option is selected, all reports will be appended.  

Save Summary Report– In Multi-Mode, summary reports can be saved. If this option is not selected and ‘Save 

Report’ is selected, Multi-Mode individual, reports will be saved but not the summary. 

Append Summary PDF—Same as Append PDF but for Multi Mode Summary reports 

 



 

 

Define Report File Name Format— Saved reports are 

named in a default format consisting of Symbology-

Data– Date Stamp. Alternate naming conventions can 

be defined as seen below. Select the fields in order 

from “Available Fields” to “Selected Fields”.  

This option can be accessed from the “File” menu- 

follow the drop down and click on “User Password Options”. 

You will be prompted to enter a password; the default is 

“user”.  

The password protection is provided for the settings menus 

and the calibration menu.  

NOTE: The default password is “user”, all lower case.  

 

 

 

 

“User Information” can be found in the “Options” menu under “User Information”. This information is also in 

the “Settings”  screen, under the “Report and Print Options” section.  

User Information- Information required on reports 

can be selected here. Company Name, Operator, 

Product Name, Batch #, Job Number, and a Logo 

path can be defined. If you check the “Windows User 

Name”  box, the “Operator”  field will be automatically 

filled in with the username of the user logged into 

Windows.  

This dialog box can also be selected from the 

‘Options Menu -> User Information’. 



This feature can be accessed by going to the 

“Help”  menu and following the drop down 

to “Revision Log”. The “Revision Log” gives 

you a history of revisions to the software. 

This will allow you to document or review 

changes made in the latest software update.  

This feature can be accessed by going to the “Help” 

menu and following the drop down to “About.” The 

“About” screen will show you your current version of 

software and its release date. 



 

The ANSI parameters section lists each of the nine ANSI parameters and gives a summary of the 

measurements based on all scans taken.  Each parameter is completely explained below. Note that some of 

these parameters are average values over all of the scans, and the averages may skew or alter the apparent 

results. For a rigorous review of the ANSI process given on each of your codes, you should check the ANSI 

Matrix for each code, described in the next section.  

 

This section may be very helpful in situations where the barcode cannot even be read. Therefore, the 

descriptions of each parameter below will explain what is measured in the case where a code is read and not 

read. When a code is not read, the scan is analyzed for apparent quiet zones, and the bars and spaces in 

between are used for the ANSI analysis. 

 

1. EDGE: Edge Determination 

Checks that each edge between bar and space can be detected and no false bars or spaces appear due to 

“splitting” of bars or ink splattered into spaces.  If at least one scan results in a decoded barcode, the EDGE 

value is the number of bars and spaces, not including quiet zones, in the code.  If no scans result in a 

decoded barcode then the EDGE value shown is the number of bars and spaces found between quiet zones 

(or apparent quiet zones) on the scan on which the most bars and spaces were found. The Scan Reflectance 

Profile graph can also be very helpful in analyzing a code that cannot be decoded. 

 

2.  Rl/RD: Minimum Reflectance 

Checks that the darkness of the bars is sufficient. Strictly speaking, the amount of light reflected by the bars 

(bar reflectance) must be less than half the light reflected by the spaces (space reflectance).  The values 

shown are the light reflectance and the dark element reflectance separated by a slash. The light reflectance is 

the maximum reflectivity found in the scan (lightest or best space), and the dark reflectivity is the minimum 

reflectivity found in the scan (darkest or best bar). The requirement is for the minimum reflectivity to be no 

more than half the maximum reflectivity. If this requirement is met, the grade will be A, otherwise it will be F. 

 

3.  SC: Symbol Contrast 

Measures the contrast between the brightest space and darkest bar. The result is assigned a letter grade of A, 

B, C, D, or F, with A being the highest contrast. The contrast is the difference between the maximum 

reflectivity (lightest or best space) and the minimum reflectivity (darkest or best bar). Note that Symbol 

Contrast is the difference between light and dark, and Rl/Rd above checks the ratio of these values. 

  A   >   70 B   55-70 C   40-55 D   20-40 F   <20    

 

4.  MinEC: Minimum Edge Contrast 

Checks that the contrast between adjacent bars and spaces is high enough.  When a barcode is scanned, a 

reading device must locate the edges between each bar and space.  If the difference in the light and dark 

elements is not significant, this may not be achieved. Note that MinEC finds the worst-case contrast difference 

between each bar to space transition, whereas symbol contrast finds the best-case difference at any point 

across the barcode. 

 

 

 

 



5.  MOD: Modulation 

Modulation checks the edge contrast as a fraction of the overall or best case contrast measured in symbol 

contrast. Modulation is an important measure of minimum edge contrast since most barcode reading devices 

employ “adaptive thresholding circuits” of some type that are sensitive to a symbol’s contrast in order to 

detect transitions between bars and spaces.  If all bars and spaces were the same brightness, the minimum 

edge contrast would be equivalent to symbol contrast.  In this case, modulation would be 100 percent. If 

some spaces are less bright than the brightest one, modulation will be some fraction of the overall contrast.  

Modulation therefore measures the amount of available contrast that is manifested in the worst-case bar to 

space transition. The percentage is assigned a letter grade. 

 

Excessive ink spread or bar growth can result in low modulation because very narrow spaces appear to be 

filled in by the encroaching bars in the Scan Reflectance Profile. If you have read down to here, you deserve a 

reward! Call Webscan at 1-877-WEBSCAN for your FREE gift. 

 

6.  Def: Defects 

The worst-case change in reflectance within a single bar or space is a defect. The largest difference in 

reflectivity found in a single bar or space is measured as a percentage of the symbol contrast and assigned a 

letter grade.  Defects normally measure breakups or voids within bars, ink spots in spaces, or even the grain 

of a substrate in spaces. This very serious issue for scanners was not directly addressed by traditional 

verification techniques. 

 

7.  DCD: Decode 

The widths of each bar and space are measured and used to interpret the data content of the barcode 

according to a specific mathematical formula appropriate for the barcode type.  If the barcode cannot be 

decoded according to the formula, the accuracy of the bar and space widths are inadequate. The printout 

shows the number of scans decoded over the number of scans taken, e.g. 8/10 means 8 out of 10 scans 

decoded. 

 

8.  DEC: Decodability 

Determines how accurate the bar and space widths are and how easily the widths can be determined. A 

perfectly accurate barcode will have 100 percent decodability, but decodability as low as 25 percent is often 

acceptable. Decodability is always measured in terms of the formula used to interpret the bar and space 

widths into the data content of the barcode.  In order to read barcodes, thresholds between element widths 

are normally established according to prescribed “decode algorithms”. Decodability is normally the 

percentage of the overall tolerance range for a bar or space width that is not used up by inaccuracies. See 

Appendix B for an example. 

 

9.  QZ: Quiet Zone 

This refers to a dedicated amount of blank space on the left and right of the barcode. Each symbology 

specifies a minimum quiet zone. For example, UPC-A barcodes should have at least a nine module quiet zone 

on each side, whereas an EAN-13 barcode permits legal quiet zones to be as small as seven modules.  

 

 

 

 



 

 

1. UEC (Unused Error Correction): This is the percentage of error correction capability that is available for 

further incorrect modules. The assignment of grade is according to the following table: 

UEC % Grade 

>  62 A 

> 50  (but less than 62) B 

> 37  (but less than 50) C 

> 25  (but less than 37) D 

< 25 F 

 

2. SC (Symbol Contrast): This is the difference in reflectivity between the brightest module and the darkest 

module. The assignment of grade is according to the following table: 

SC % Grade 

> 70 A 

> 55  (but less than 70) B 

> 40  (but less than 55) C 

> 20  (but less than 40) D 

< 20 F 

 

3. MOD and RM (Modulation): This is a grade based on the amount of variability in reflectivity of the modules.  

A multi-step process is used to get the modulation grade. First the reflectivity of each module is compared to 

the global threshold and the overall symbol contrast according to the following formula: 

MOD = 2 * (abs(R - GT)) / SC 

The Global Threshold GT is the midpoint between the reflectance of the brightest module and the reflectance 

of the darkest module. Next, the grade level for each module is determined from the MOD value according 

to the following table: 

MOD % Grade 

> 50 A 

> 40  (but less than 50) B 

> 30  (but less than 40) C 

> 20  (but less than 30) D 

< 20 F 

Finally, the value of the grade for the MOD parameter will be the highest modulation level for which the 

modules meeting that level will result in an Unused Error Correction grade of that level or higher. The module 

with the lowest MOD is reported as Contrast Uniformity (CU) in General Characteristics to facilitate 

conformance testing to the requirements of ISO/IEC 15426-2. 

4. ANU (Axial Non-uniformity): This is the amount of “out of square” a symbol is, or in other words, a measure 

of the overall aspect ratio of the symbol. 



ANU % Grade 

≤ 6 A 

< 8  (but more than 6) B 

< 10  (but less than 8) C 

< 12  (but less than 10) D 

> 12 F 

 

5. GNU (Grid Non-uniformity): This is the worst-case distance between the calculated center of a module and 

the ideal location for the center of the module based on perfectly evenly spaced modules. The calculated 

center of the module is determined using clock tracks. The value is reported as a percentage of a module 

size. 

GNU % Grade 

≤ 38 A 

< 50  (but less than 38) B 

< 63  (but less than 50) C 

< 75  (but less than 63) D 

> 75 F 

 

6. FPD (Fixed Pattern Damage): This is the overall grade for all the fixed pattern components. This grade is equal 

to the lowest grade of all the components listed below. The following is a list of components of the finder 

pattern. 

7. LLS (Left ‘L’ Side): This is a grade based on imperfections in the left ‘L’ side of the finder pattern. There are 

two checks required to pass. The first requires gaps to be three modules or less and that gaps are separated 

by stretches of at least four correct modules. The second assigns a grade based on the overall percentage of 

correct modules according to the following table: 

 % of incorrect modules Grade 

0 A 

< 9 (but more than 0) B 

< 13    (but more than 9) C 

< 17   (but more than  13) D 

> 17 F 

The grade is the highest modulation level in which the first (gap test) passes and the correct module 

percentage results in a grade of that level or higher. 

8. BLS (Bottom ‘L’ Side): This is a grade based on imperfections in the bottom ‘L’ side of the finder pattern (see 

Left ‘L’ Side). 

9. LQZ (Left Quiet Zone): This is a grade based on imperfections in the quiet zone, which is a one-module area 

to the left of the left ‘L’ side. The grade is based on the percentage of modules, which are correct using the 

same grading table as for the ‘L’ sides. 

10. BQZ (Bottom Quiet Zone): This is a grade based on imperfections in the quiet zone, which is a one-module 

area below the bottom ‘L’ side. 



 

11. TQZ (Top Quiet Zone): This is a grade based on imperfections in the quiet zone, which is a one-module 

area above the top clock track. 

a. ULQZ (Upper Left Quiet Zone): This is the top quiet zone above the upper left quadrant (Used only 

for 2 and 4 quadrant symbols, this is the grade based on the segment of the quiet zone above the 

top clock track of the left quadrant). 

b. URQZ (Upper Right Quiet Zone): This is the top quiet zone above the upper right quadrant (Used 

only for 2 and 4 quadrant symbols, this is the grade based on the segment of the quiet zone 

above the top clock track of the right quadrant). 

12. RQZ (Right Quiet Zone): This is a grade based on imperfections in the quiet zone, which is a one-module 

area to the right of the Right Clock Track. 

a.  RUQZ (Right Quiet Zone to the right of the upper right quadrant): Only for 2 and 4 quadrant 

symbols, this is the grade based on the segment of the quiet zone to the right of the upper right 

quadrant. 

b. RLQZ (Right Quiet Zone to the right of the lower right quadrant):  Only for 4 quadrant symbols, 

this is the grade based on the segment of the quiet zone to the right of the lower left quadrant. 

13. TTR (Top Transition Ratio): This is a grade based on imperfections in the top clock track, with relation to its 

adjoining quiet zone. The ratio is the number of transitions from light to dark or dark to light in the quiet zone 

divided by the number of transitions in the clock track. Since the number of transitions in the quiet zone 

should be zero, the ideal value for this parameter is zero. However, a small number of transitions can be 

tolerated as long as the ratio remains relatively low. As the number of teeth in the clock track increases (larger 

symbols) more transitions in the quiet zone can be tolerated. Also, more transitions in the clock track (which 

are really imperfections) will tend to improve this measurement. The grading scheme for this transition ratio is: 

Transition Ratio % Grade 

< 6 A 

< 8 (but more than 6) B 

< 10    (but more than  8) C 

< 12   (but more than 10) D 

> 12 F 

The value of the grade will be the highest modulation level for which the ratio gives a grade from the above 

table of that modulation level or higher. 

a. ULQTTR (Transition ratio for Upper Left Quadrant Top Clock Track): Only for 4 quadrant symbols, 

this is the grade based on the clock track segment at the top of the upper left quadrant. For a 2 

quadrant symbol, this will be labeled LQTTR. 

b. URQTTR (Transition ratio for Upper Right Quadrant Top Clock Track): Only for 4 quadrant 

symbols, this is the grade based on the clock track segment at the top of the upper right 

quadrant. For a 2 quadrant symbol this will be labeled RQTTR. 

c. LLQTTR (Transition ratio for Lower Left Quadrant Top Clock Track): Only for 4 quadrant symbols, 

this is the grade based on the clock track segment at the top of the lower left quadrant. 



d. LRQTTR (Transition ratio for Lower Right Quadrant Top Clock Track): Only for 2 and 4 quadrant 

symbols, this is the grade based on the clock track segment at the top of the lower right 

quadrant. 

14. RTR (Right Transition Ratio): Transition ratio (see Top Transition Ratio) for the right clock track in relation to 

the right quiet zone. 

a. ULQRTR (Transition ratio for Upper Left Quadrant Right Clock Track): Only for 2 and 4 quadrant 

symbols, this is the grade based on the clock track segment to the right of the upper left 

quadrant. For a 2 quadrant symbol, this will be labeled LQRTR. 

b. URQRTR (Transition ratio for Upper Right Quadrant Right Clock Track): Only for 2 and 4 quadrant 

symbols, this is the grade based on the clock track segment to the right of the upper right 

quadrant. For 2 quadrant symbols, this will be labeled RQRTR. 

c. LLQRTR (Transition ratio for Lower Left Quadrant Right Clock Track): Only for 4 quadrant symbols, 

this is the grade based on the clock track segment to the right of the lower left quadrant. 

d. LRQRTR (Transition ratio for Lower Right Quadrant Right Clock Track): Only for 4 quadrant 

symbols, this is the grade based on the clock track segment to the right of the lower right 

quadrant. 

15. TCT (Top Clock Track): This is a grade based on imperfections in the top clock track.  Some imperfections in 

the clock track can be tolerated.  However, the rule that must be maintained for a passing grade is that three 

out of every five modules (on a consecutively rolling window of five modules) must be correct. The value of 

the grade will be the highest modulation level for which this test passes. 

a. ULQTCT (Top Clock Track for Upper Left Quadrant): Only for 2 and 4 quadrant symbols, this is 

the grade based on the clock track segment at the top of the upper left quadrant. For 2 quadrant 

symbols this will be labeled LQTCT. 

b. URQTCT (Top Clock Track for Upper Right Quadrant): Only for 2 and 4 quadrant symbols, this is 

the grade based on the clock track segment at the top of the upper right quadrant. For 2 

quadrant symbols this will be labeled RQTCT. 

c. LLQTCT (Top Clock Track for Lower Left Quadrant): Only for 4 quadrant symbols, this is the grade 

based on the clock track segment at the top of the lower left quadrant. 

d. LRQTCT (Top Clock Track for Lower Right Quadrant): Only for 4 quadrant symbols, this is the 

grade based on the clock track segment at the top of the lower right quadrant. 

16. RCT (Right Clock Track): This is a grade based on imperfection in the right clock track (see Top Clock Track). 

a. ULQRCT (Right Clock Track for Upper Left Quadrant): Only for 2 and 4 quadrant symbols, this is 

the grade based on the clock track segment to the right of the upper left quadrant. For 2 

quadrant symbols, this will be labeled LQRCT. 

b. URQRCT (Right Clock Track for Upper Right Quadrant): Only for 2 and 4 quadrant symbols, this is 

the grade based on the clock track segment to the right of the upper right quadrant. For 2 

quadrant symbols, this will be labeled RQRCT. 



 

c. LLQRCT (Right Clock Track for Lower Left Quadrant): Only for 4 quadrant symbols, this is the 

grade based on the clock track segment to the right of the lower left quadrant. 

d. LRQRCT (Right Clock Track for Lower Right Quadrant): Only for 4 quadrant symbols, this is the 

grade based on the clock track segment to the right of the lower right quadrant. 

17. AG (Average Grade of Damage across many parts of the Finder Pattern): This is a grade that considers 

the accumulated effect of damage to several parts of the finder pattern. Five values are averaged together.  

One of these is the lowest of all the grades associated with all the clock track segments, namely TCT, TTR, 

TQZ and RCT, RTR, RQZ. The other four are LLS, BLS, LQZ, and BQZ. The average must fall in the range of 

0.0 through 4.0 and is given a grade according to the following: 

Ave Grade Grade 

Equals 4.0 A 

 3.5  (but less than 4.0) B 

 3.0  (but less than 3.5) C 

 2.5  (but less than 3.0) D 

< 2.5 F 

NOTE: The effect of the AG parameter is to lower the overall grade of symbols, which have several individual 

parameters at or near the same level.  For instance, with enough B grades in individual parameters, the 

overall grade may come out as a C grade rather than a B. 

18. Contrast Uniformity (CU): This is the value of MOD (modulation) for the worst case module selected from 

a 2D Matrix symbol. This is useful for process control, as way of measuring the drift in reflectivity 

consistency, and more importantly for testing conformance to ISO/IEC 15426-2 which requires the 

modulation of a specific module within a conformance test symbol to be reported. This parameter is not 

graded, nor listed in the Quality Detail tab. Rather, it is reported in General Characteristics. 

 

The AIM-DPM method of grading data matrix symbols modifies the process of ISO-15415 and is more 

appropriate for direct part marking applications. This standard was developed to be more representative of 

the scanning performance of modern readers that in some cases are specifically designed for these 

demanding applications. 

In this method, the image brightness is adjusted to produce an image of the symbol that fills most or all of 

the dynamic range of the imager, resulting in an image that is easier to see. Additionally, the threshold 

between dark and light is calculated from the statistics of the image brightness histogram. Thus, the 

measurements calculated by AIM-DPM differ from those of ISO 15415 significantly. 

Some of the parameters reported in ISO 15415 are changed so drastically that in order to remove the 

possibility of confusion between these two methods, the parameters have been renamed. These parameters 

are:   



 

AIM-DPM Parameter Name ISO 15415 Parameter 

Name 

Summary of Change(s) 

CC (Cell Contrast) SC (Symbol Contrast) Made relative to light background 

CM (Cell Modulation) MOD (Modulation) 
Threshold calculated from statistics rather 

than the maximum and minimum 

reflectance. Grading scale range set to 

Mean of distribution, rather than maximum 

and minimum reflectance 

 DD (Distributed Damage) AG (Average Grade) Modulation overlay uses only A, B, and F 

levels instead of A, B, C, D, and F. 

MR (Minimum Reflectance) Not necessary since SC is 

measured on an absolute 

scale 

An absolute limit on SC of 5% added to 

temper the relative nature of CC. 

All of the Fixed Pattern Damage grading (other than AG shown above) are not renamed, but are functionally 

different since the global threshold and modulation grading scale are different. In general, symbols will obtain 

a significantly higher grade according to AIM-DPM than ISO 15415. Therefore, grading according to AIM-

DPM is appropriate only when called for in an application specification. 

Another significant difference is the allowance for a variety of illumination options. These include the four-

sided 45˚ light that is the default for ISO 15415. Additionally allowed are: 30˚ lighting from four sides, 30˚ from 

two sides (which can be either North/South or East/West), and 90˚diffuse on-axis lighting. The light source 

that is used is reported using a notation that includes the angle, and a letter (Q for 4, T for two). 

AIM-DPM also varies the size of the aperture until the symbol is decoded, and then the grading is repeated 

with two different aperture sizes (50% and 80%) and the better of the two grades is reported as the final 

grade. 

The parameters, which are new or significantly modified for AIM-DPM, are explained below: 

1. CC (Cell Contrast): This is the relative contrast value between bars and spaces, taken from the means of the 

light and dark element CC = (Lmean - Dmean) / Lmean 

CC % Grade 

≥ 30% 4 

≥ 25% 3 

≥ 20% 2 

≥ 15% 1 

< 15% 0 

 

2. CMOD (Cell Modulation): Similar to MOD in ISO 15415, this parameter measures the deviation in the 

reflectivity of dark and light elements.  A range for each group (light and dark) is created from the 



 

global threshold to the mean reflectance of the elements.  Each module is graded along this range, 

then error correction capability is considered to “discount” the effect of one or a few elements with low 

values, and a final grade for this parameter is computed. 

 

3. DDG (Distributed Damage Grade):  Similar to AG in ISO 15415, this parameter takes into account the 

effect of multiple segments of the fixed pattern having imperfections.  Where multiple segments have a 

low grade, the effect of this “distributed damage” is reflected in a lower grade for DDG than the lowest 

of the individual segments. 

4. MR (Minimum Reflectance):  This is a requirement for at least 5% reflectance difference between light 

and dark elements, as a restraint on the purely relative CC parameter. 

5. Decode: Decode grade A or F depending upon whether the reference decode algorithm succeeds in 

decoding the symbol with the required final aperture size. 

 

1. Distortion Angle (DA): The angle between the left side and the bottom side of the ‘L’ finder pattern 

should be 90 degrees. The distortion angle is the deviation from 90 degrees exhibited by the ‘L’ in this 

symbol. A distortion angle of 7 degrees or less will Pass, while a larger distortion angle will Fail. 

2. Cell Fill (Size): The size of the cells must be printed at least 60% of the cell spacing, and no more than 

105% of the cell spacing. 

3. Ovality: For dot peen symbols (where the cells are allowed to be round) the cells should be circular.  As 

a measure of ovality, the ratio of the widest diameter to the smallest diameter is checked and must be 

less than 20% different in order to Pass. 

4. Center Offset: The center of each cell must not be offset from its correct grid location by more than 

20% of the cell spacing in order to Pass. 

5. Symbol Contrast: Symbol contrast should be at least 20% to Pass. 

 

 

 

 

 

ISO 16022 Parameters: 

Decode (DCD), Symbol Contrast 

(SC), Bar Width Growth (BWG), 

Axial Non-Uniformity (ANU), 

Unused Error Correction (UEC) 



DCD: Indicates whether the symbol was decoded by the reference decode algorithm. 

Symbol Contrast: Represents the difference between reflectance of light and dark elements. 

BWG: Represents the bar width growth as defined in ISO 16022.  

ANU: Represents Axial Non-Uniformity, which represents non-square aspect ratio of the modules in the 

symbol. 

UEC: Represents Unused Error Correction, which indicates the amount of error correction used out of the 

budget for error correction available in the symbol. 

PCS, MRD, SC, MinEC and MOD – Ways of Quantifying Contrast: PCS, Print Contrast Signal, is an older and 

largely no longer used measure of contrast. Contrast is intended to quantify the difference between the bars 

and the spaces in reflectance. PCS is defined mathematically as:  

PCS = (Rmax-Rmin) / Rmax  

In other words, the percentage of the light background accounted for by the difference between the bars and 

spaces. This measure was defined as a measure of perceived contrast by the human eye, long before and 

outside the context of measuring barcode contrast. Notice that the measurement is made relative to the 

brightness of the background. The fact that it is relative to the background means that the darker (worse) the 

background color is, the higher (supposedly better) the value of PCS. This may correspond with the way 

people view things, but not really, how scanners work. Rather, scanners are sensitive to the absolute 

difference between the reflectance of bars and spaces. Scanners are especially sensitive to variations in 

contrast within the same scan.  

Another measurement, called MRD (minimum reflectance difference) quantifies the minimum difference 

anywhere across the barcode. MRD considers the brightest (worst) bar and the darkest (worst) space 

anywhere in the barcode. These worst case bar and space need not be adjacent to one another.  

NOTE: ANSI grading system defines yet a different way of measuring contrast: SC (symbol contrast) and 

MinEC (Minimum Edge Contrast.) SC is the difference between the brightest (best) space and darkest (best) 

bar. Minimum Edge Contrast is the smallest difference occurring between adjacent bars and spaces (across a 

single edge). MOD (Modulation) is simply the ratio between MinEC and SC, in other words, the percentage of 

available contrast that is manifest in the worst-case edge. 

Bar Width Growth: Bar Width Growth is a measure of ink spread. The measurement of bar width growth is 

different on each symbology, and requires at least one successful decode of the symbol for measurement. 

Generally, bar width growth is taken on groups of bars and spaces, sometimes large groups. This results in 

stable results when bar width growth is uniform, but does not catch isolated cases of a single bar widening or 

shrinking. In fact, it is possible to have a very low (good) reading of bar width growth when in fact a large 

number of even all the bars and spaces are incorrectly grown or reduced, as these may tend to cancel each 

other out. Such bar width inaccuracies will normally be detected by low grades of Decodability. 



 

• The TruCheck™ Omni can be used in two modes: Single-Mode and Multi-Mode.  

• Single-Mode will decode a single symbol at a time, and is useful for quick, simple verification of isolated 

symbols.  

• When the application is started for the first time, it will be in “Single-Mode”.  

• To switch to “Multi-Mode”, select “File->Switch to 

Multi-Mode”. This will restart the software in “Multi-

Mode”.  

• In “Multi-Mode”, any number of symbols may be 

verified per verification cycle.  

• Before any verification has taken place, the 

software will show an image that was taken during 

start up, and the camera will be in an inactive state. 

To proceed to verify symbols, press the large 

button near the top center that reads “Go Live”.  

Presenting the Sample to be verified  

• In “Live Mode”, the camera will capture images and update the display several times every second. At this 

point, the symbols to be verified should be placed on the TruCheck™ Omni unit, face-down on the glass 

viewing window.  

• Images of the sample to be verified will then be visible on the screen. Adjust the sample on the window so 

that all symbols to be verified are within the field of view, and that the sample sheet is flat and flush against 

the window. Failure to ensure that the symbols are flush against the window can result in poor verification 

results.  

 

 

 

 

 



• Select the regions to be verified. To do this, click and drag starting beyond the upper left of a symbol to be 

verified, and releasing beyond the lower right of the symbol. Repeat this for each symbol to be verified.  

• If the region selected is approximately square, the selected region will be given the default settings for a 2D 

symbol region. If the region is more rectangular, the region will be given the default settings of a 1D region.  

 • Selected regions can be deleted by right clicking on a 

region, and selecting “Delete”. To delete all regions, 

right click in an area outside of any selected region, and 

select “Delete All Selections”.  

• The layout and group affiliation of regions on the 

screen can be saved and recalled at a later time. This is 

useful if similar samples are frequently verified. To do 

this, layout the regions and assign groups as desired, 

and then select “File->Save Setup”. This will save a setup 

file that can be restored at a later time.  

• To restore a saved setup file, select “File->Open 

Setup”.  

• With the regions selected, decode settings must be selected to match the intended application. Settings can 

be adjusted by right clicking inside a selected region, and selecting “Settings”.  

• Settings are common among all regions that are part of the same group. By default, all regions selected will 

belong to the same group, so if a large number of symbols are to be verified using the same settings, it is 

only necessary to change the settings on one of the regions.  

• Regions are always set as either “1D” or “2D”. This determines if the region will be searched for 1D or 2D 

symbols upon verification. This is a setting like any other, so changing this setting for one region will apply the 

change to all regions in that region’s group. 

 • If two regions that are in the same group need to be verified with different settings, then it is necessary to 

move one of them to a different group. To do this, right click on the region and select “Switch to Group-

>New Group”.  

• This will create a new group with this region as its only member. More regions can be added to this group 

by instead selecting “Switch to Group->” and selecting the appropriate group.  

 • Groups are color-coded; regions that are of the same color are members of the same group. The settings 

for each group apply only to the regions that are members of that group.  



 

• When selecting regions, approximately square regions are created as 2D regions, and rectangular regions 

are created as 1D regions. If a 1D region is created when previous regions were 2D, then the newly created 

region will be put into a new group, and vice versa.  

• Once the settings for all groups have been established, the global settings can be set. These settings can be 

accessed by selecting “Options->Settings”.  

• The global settings are used for record keeping and reporting purposes. It is in these settings that user 

information can be set and digital copies of the reports can be saved. For more information on the use of 

these settings, please see the user guide, available in the Webscan Inc. folder in the start menu.  

• Now that all regions have been selected and settings have been set, the symbols can be verified. To do this, 

press the button that reads “Verify Code”. Note that this is the same button that read “Go Live” before.  

• The verification process will proceed to verify each region, according to that region’s settings. This may take 

a moment. To help the verification process complete quickly, make sure that all regions contain a symbol.  

• Once verification has completed, there are 

several tools available to help to analyze the 

results of the verification process.  

• First of all, each region will no longer be 

colored according to its group affiliation, but 

rather according to grade of the verified symbol 

within. Regions will be green if the grade is 

either an “A” or a “B”, yellow if the grade is a 

“C”, or red if the grade is “D” or “F”.  

• It is important to note that the region will be 

red if no symbol is decoded. “NO DECODE” is 

treated as an “F” grade for reporting purposes.  

 • To view a quick overview of the performance of 

the decoded symbols, there is a chart in the lower 

right hand corner labeled “Verification Summary”. 

This chart will show the relative frequency of the 

three grade categories (green, yellow, red) as 

described above.  

• To access a printable summary report, click on the 

tab near the top left of the screen labeled 



“Summary”. This is a printer friendly report that summarizes the results of the verification. The report will 

begin with some information about the results of all regions combined, indicating the number of each grade 

received, then a small subsection for each region, including basic information for each symbol.   

 

 • For a more thorough report, click on the tab labeled “Report” near the upper left. This will include a detailed 

report for every region, including information about the symbol’s overall grade and all other information that 

was selected in the settings menu.  

• Like the summary report, these reports are 

also printer friendly. To print the report, right 

click on the report, and select “Print Report”.  

• These detailed reports are an ideal way to 

keep and maintain a record of verification 

results, as they will contain all information 

relating to acceptance criteria, as well as a date 

and time to establish when the verification was 

completed. Note that what information is 

reported here is controlled by both the settings 

for the region and the global settings.  

• Results can also be reviewed on screen, and can be 

accessed either by double clicking on a region or by 

double clicking on the row of the “Summary Results” 

table on the upper right. This will create a popup 

window with detailed information about the symbol 

that was decoded.  

 • There are several tabs and buttons available in this 

window, and they function exactly as they do in “Single 

Mode”. For information on what information is 

presented in these tabs, please see the user guide, 

available in the Webscan Inc. folder in the start menu.  

 

 

• Once the results have been reviewed, and all desired reports have been printed, press “Go Live” to return to 

the state where new symbols can be presented, and the selected regions can again be modified. 



 

This section contains essential information to properly install, operate and maintain your Webscan TruCheck™ 

Laser USB Barcode Verifier. 

The Webscan TruCheck™ Barcode Verifier complies with standard 21CFR1040.10.   

Caution - use of controls or adjustments or performance of procedures other than those specified herein may 

result in hazardous laser light exposure. The type and location of warning labels that comply with the CDRH 

standard are illustrated below: 

The label below indicates the location of the aperture through which laser light is emitted. 

 

 

AVOID EXPOSURE - Laser light is 

emitted from this aperture 

 

 

The label below is located on the bottom of the unit and indicates the Model Number and Date of 

Manufacture: 

Model#  

Manufactured 

Serial# 

Webscan, Inc. 

1341 Sherman Dr. Unit D 

Longmont, CO 80501 

 

The label below indicates that this product is a Class II laser device and contains the FDA Class II Warning 

logotype: 

 

 



The label below contains the FCC Compliance Statement, the CDRH Compliance Statement and the caution 

statement for protective housings without interlocks. 

 

This equipment complies with Part 15 of the FCC rules.  Operation is 

subject to the following two conditions: (1) This device may not cause 

harmful interference, and (2) This device must accept any interference 

received including interference that may cause undesired operation. 

 

Complies with 21CFR1040.10 

CAUTION - Laser light when open.  DO NOT STARE INTO BEAM. 

 

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this 

device may not cause harmful interference, and (2) this device must accept any interference received, 

including interference that may cause undesired operation.   

 

Besides periodic calibration, your Webscan system requires a minimum amount of care and maintenance. In a 

very dusty environment, it is necessary to clean the window surface from time to time.  It is recommended 

that you use a soft cloth, similar to the type used on eyeglasses or camera lenses. Warm water may be used 

along with a gentle cloth. Slowly wipe up and down making sure to clean the entire width of the window.  

Accuracy of the optical parameter measurements are to ISO15426 (Barcode Verifier Conformance 

Specifications), as follows:  

 

The arithmetic mean of the measurements on 10 scans on a Primary Reference Test Symbol shall be within 

Decodability: +8%, Rmin: +3%, Rmax: +5%, Defect: +8%, Modulation: +12% (not specified in ISO15426, but 

our specified tolerance)  

 

 



 

NOTE: The units of the tolerance are percentage of 100%, in other words reported units, not percentage of 

the reading. Example: For a Test Symbol with decodability of 88%, a reading in the range 80% through 96% is 

within these tolerances. In most cases, measurements are more accurate than those stated above.  

 

a. Final Quality Grade: Scale of 0.0 to 4.0, to a resolution of 0.1.  

 

b. Individual Parameters: Reported on a scale of 0 to 100 with resolution of 1. The resolution of measurement 

is not an indication of accuracy.  

 

Refer to of ISO/IEC 15426-1 and ISO/IEC 15426-2.  

 

All TruCheck models have a means of calibrating reflectance values against reference reflectance calibration 

samples. Two calibration points are used, one near the high reflectance end of the range and the other near 

the low reflectance end of the range. The reflectance calibration target specified by Webscan is the GS1 

Calibrated Conformance Standard. This NIST traceable standard is a product of GS1, and is available through 

Webscan, Inc. or from GS1 directly. 

 

The calibration procedure specified by Webscan, Inc. is documented in the  section earlier in this 

manual.  

 

 

Temperature 0-40° C, Humidity: 5% - 95% non-condensing 

  



The following pages contain compliance certificates for existing Model numbers of TruCheck barcode verifiers 

as of the time of publishing of this manual. Contact Webscan if your model is not listed. 

Webscan certifies that the following product models: 

TruCheck Omni Series: 

Model# TC-830, TC-839, TC-836, TC-833, TC-827, TC-832, TC-840, TC-846 

 

TruCheck Optima Series: 

Model# TC-829, TC-838, TC-835, TC-834, TC-842, TC-844 

 

TruCheck 2D USB Series: 

Model# TC-823, TC-831, TC-826, TC-821, TC-832 

 

TruCheck 2D DPM USB Series: 

Model# TC-824, TC-845, TC-825, TC-850, TC-853 

 

TruCheck Laser USB: 

Model# TC-843, TC-854, TC-841, TC-847, TC-837, TC-848, TC-857, TC-851, TC-855 

 

 TruCheck Rover: 

  Model# TC-501 

 

Comply with GS1 system requirements for EAN/UPC Symbology, UCC/EAN-128 Symbology, ITF-14 

Symbology, GS1 DataBar Symbology and GS1 Composite Symbology and GS1 Data Matrix.  

And furthermore, with the following applicable ISO/IEC standards: 

 

ISO 15415 

ISO 15416 

ISO 15426-1 and 15426-2 

ISO/IEC TR 29158 (AIM DPM-2006) 

for 

Data Matrix (ISO/IEC 16023) ECC-200 (up to 48x48 matrix size) 

QR Code (ISO/IEC 18004) 

Aztec Code (ISO/IEC 24778) 

PDF 417 (ISO/IEC 15438). 

 

Evidence of compliance with the aforementioned standards and traceability to National Institute of Standards 

and Technology (NIST) is provided through the use of GS1 Certified Calibrated Conformance Standards which 

are manufactured to exacting specifications and test for conformance to ISO 15426 parts 1 and 2. 

 

Webscan tests each unit for conformity within specified tolerances per ISO 15426 parts 1 and 2. 



 

Some barcode symbologies (especially 2D symbologies) can encode ASCII characters that are unprintable 

and therefore difficult to represent in the printed reports.  A special pattern is used to represent these 

characters using a consistent notation of two letters, which represents the ASCII code, surrounded by 

brackets. 

The codes are as follows: 

ASCII Code Value (decimal) ASCII Code name Special Pattern Used 

0 NULL <NU> 

1 SOH <SH> 

2 STX <ST> 

3 ETX <ET> 

4 EOT <EO> 

5 ENQ <EN> 

6 ACK <AC> 

7 BEL <BE> 

8 BS <BS> 

9 HT <HT> 

10 LF <LF> 

11 VT <VT> 

12 FF <FF> 

13 CR <CR> 

14 SO <SO> 

15 SI <SI> 

16 DLE <DL> 

17 DC1 <D1> 

18 DC2 <D2> 

19 DC3 <D3> 

20 DC4 <D4> 

21 NAK <NK> 

22 SYN <SY> 

23 ETB <EB> 

24 CAN <CA> 

25 EM <EM> 

26 SUB <SU> 

27 ESC <ES> 

28 FS <FS> 

29 GS <GS> 

30 RS <RS> 

31 US <US> 



NOTE: The special patterns always consist of two letters, even though the name of the ASCII code sometimes 

contains more than two characters (example EOT, BEL, etc.). This is to preserve regular column spacing in the 

printed reports and to make it easier to parse the data strings. 

This section contains information about specific symbologies and points out specific parameters that will be 

reported particular to that symbology. 

UPC/EAN is a family of linear barcodes used at point of sale. The structure of 

a UPC/EAN barcode consists of leading guard bars, central guard bars, and 

trailing guard bars. The data characters consist of 4 elements comprising 7 

unit modules, which encode digits 0-9. UPC codes encode 12 digits and EAN 

codes encode 13 digits. The first digit in an EAN barcode determines the GS1 country code of the country that 

the company is based. 

It is customary to report the size of a UPC/EAN symbol in terms of magnification, not by X dimension. 

Therefore, when UPC/EAN symbols are verified, the General Information section will contain a parameter 

called "Magnification". (Note: A 100% Magnification UPC symbol has an X dimension of 13 MILS, or .013 inch). 

Code 128 is a very common and popular linear symbology.  It has been 

adapted for use with the GS1 system, and barcodes utilizing the GS1 format 

of Code 128 are known as either UCC/EAN-128 or now GS1-128.  A GS1-128 

barcode contains a Function-1 character immediately after the start 

character. 

The structure of a Code 128 bar code consists of a start character, a variable number of data characters, a check 

digit character and a stop character. Each character consists of 6 elements (3 bars and 2 spaces) comprising 11 

modules, except the stop character which contains an extra bar at the end which serves to close off the last 

space of the stop character. Data is encoded in one of three character sets (referred to as character Set A, B, 

and C), allowing for double density numeric encodation as well as encoding all possible ASCII characters (ASCII 

values 0 through 127). Code 128 is embodied in many application specifications, including barcode GS1-128 

symbology (formerly UCC/EAN-128). 

The Code 128 symbology can encode data using three different "character sets" or more specifically, mappings 

between symbol characters and data characters known as Character Set A, Character Set B, and Character Set 

C. The Data Detail Tab will show the encodation of Code 128 symbols, displaying each symbol character and 

the corresponding data encoded. The particular start character that was used, control characters that switch 

between character sets, check digit, and stop characters are all shown. The data encoded uses the two-character 

notation for unprintable ASCII characters defined in 14.2 ASCII Code Representation. 



 

For Code 128, the element widths will contain a summary showing minimum, average, and maximum values for 

one, two, three, and four module bars and spaces separately, as well as the measured elements’ widths and 

deviations from nominal. 

Code 39 is a discrete two-width symbology composed of characters containing 

nine elements, three of these nine being wide elements. The wide elements are 

a fixed multiple of the narrow element width. The multiple should be in the 

range of 2 to 3. This multiple is commonly referred to as the "Ratio" and is 

reported in General Characteristics. 

The TruCheck also supports TLC 39. TLC 39 is a variant of Code 39 created to support a linked composite 

component for Telecom applications. 

Interleaved 2 of 5 is a continuous two-width barcode symbology. ITF 14 is a GS1 form of I 2 of 

5, and the TruCheck™ USB software will evaluate symbols encoded according to selected 

standards, either I 2 of 5 standard, or GS1 – ITF14. In order to select which standard is applied, 

there is a drop down menu box in the decode options of the settings window. Since Interleaved 

2 of 5 is a two-width symbology, ratio will be reported in General Characteristics. 

Code 93 is a linear symbology composed of characters made up of six elements fit 

into 9 modules. 

 

Pharmacode symbols (also known as "Laetus Pharmacode" are linear symbols 

that contain no start/stop characters. By default, the TruCheck™ verifier will not 

detect Pharmacode symbols, so if Pharmacode symbols are to be verified, there is 

an option in the “type of code” section of the settings menu that must be 

checked. It is recommended that you activate this setting only when needed, because stray marks and other 

types of symbols can sometimes have the proper spacing to qualify as a valid Pharmacode symbol. This issue 

can be avoided by turning off Pharmacode whenever Pharmacode symbols are not being verified.  

Due to the lack of any start character or other means to determine the forward direction of the symbol, a 

Pharmacode symbol can read differently in each direction. Therefore, the data in a Pharmacode symbol is 

reported twice, in both the data field of the main screen, as well as the data detail tab. An “F”, expressing the 

data as interpreted by a foreword scan, indicates the first. The second is indicated by an “R”, indicating the data 

as interpreted by a reverse scan. 
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MSI and Plessey codes are continuous binary symbologies in which data is encoded 

by groups of 4 bars and four spaces. Each bar/space pair represents a one or zero 

based on whether the bar or space is wide while the other is opposite. Groups of four 

such "bits", form a character. There is a check digit at the end, which can be displayed 

or removed from the data on the report depending on a settings choice. 

The design of PDF 417 provides for the symbol being “line scanable”.  First, 

each row is composed of self-clocking characters, much the same way as an 

ordinary linear barcode. The ’417′ in the name of the symbology comes from 

the structure of each character.  It is 8 elements (4 bars and 4 spaces) 

arranged within 17 unit modules. (The ‘PDF’ part of the name stands for 

‘portable data file’ and suggests that the data capacity of the symbol is large 

enough to represent all of the data associated with the item that the label is on, as opposed to a number that 

refers to a record in a non-portable data file (such as a price look table) in a computer database. 

Each row can be read in a way that is similar to the process of reading a linear barcode.  However, each row 

further contains a special character at each end (adjacent to the start and stop characters) which identify the 

row number within the symbol for this row. There is also other information in these special characters, including 

the total number of rows and the total number of columns in the symbol. In this way, a scan of a PDF 417 

symbol can yield part of the decode information of the symbol which can be combined with other scans (of the 

other rows) to result in a complete decode.  Thus, PDF 417, like other multi-row stacked symbologies are “line 

scanable”.  

For PDF 417, the number of rows and columns (in the data section, not including the row indicator columns) 

will be given in the General Characteristic’s section, along with Error Correction information, such as Error 

Correction Level (which can be 0 through 8), Error correction budget, number of errors and erasures. In addition, 

the scan-reflectance-profile grade for the start and stop characters is given in General Characteristics for each 

in tracing the cause of the final grade. General Characteristics will also contain the Aspect Ration which is the 

row height divided by the module size. (Thus, a symbol with row height that is 3X will have aspect ratio of 3). 

Also, a Compact PDF 417 symbol (one with its right row indicator and stop character) will be noted in General 

Characteristics. 

GS1 DataBar is a linear symbology that can be printed in multi-row stacked forms in 

many cases. Even GS1 symbols that have only 1 linear component should be treated 

as stacked symbols for the purposes of setting up a scan region. GS1 DataBar must 

be enabled in the “type of code” section of the settings menu. The “# of scans” option in the settings menu 

has no effect on GS1 DataBar symbols; the appropriate number of scans will be decoded according to the 

technical specifications, and is typically ten per row, or composite section of the overall code. 
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The reporting for RSS symbols is different than other symbologies when there is more than one component. 

Each component has its own grade. The grade of each component will affect the grade for the whole symbol, 

where the overall symbol grade is the lowest grade scored by any of its components.  

It is important to note that there is a special flag inside the data of RSS codes that identifies the presence of a 

secondary component. If this flag is set when there is no composite component found, the grade for the 

symbol is reported as “F” even if all other parameters receive high grades. This is reported as “link flag set, but 

composite component not found” in the primary report. The report will contain "Link Flag On" or "Link Flag 

Off". The report will also indicate whether the symbol is printed in one row, or "stacked". 

QR Code, or Quick Response Code, is capable of encoding Japanese Kanji characters and is 

widely used in Asia. It contains easy to decode finder patterns, alignment patterns, and clock 

tracks. A small amount of version information is specified by a group of modules surrounding 

the finder patterns, such as the size of the matrix and the selected level of error correction. QR 

Code symbols can have varying amounts of error correction, allowing a tradeoff between symbol size and 

error correction capability to be made when the symbol is created. The general characteristics section will 

include information specific to QR Code, including the error correction mode and the masking pattern. 

The Data Matrix symbology is probably the most common 2D Matrix. It allows for the 

highest density of data per module, especially for small symbols, so data matrix grading is 

essential. The finder pattern consists of solid left and bottom sides, which form an “L” 

pattern and a horizontal and vertical clock track on opposite sides of the “L”. The clock track 

tells the number of modules in the matrix and is used to decode the grid on which the 

modules are placed. There is no version information encoded explicitly within the Data Matrix symbology; all 

the information about the symbol size, encoding and error correction is determined from the size of the 

matrix. 

The matrix size shown in the general description section of the report will give the size of the matrix including 

the “L” patterns and clock tracks, and the size of the inner matrix of data encoding modules in parenthesis. 

MaxiCode is a 2D hexagonal grid symbology. “MaxiCode” must be selected in the “type of 

code” section of the settings menu to decode MaxiCode symbols. Unlike most other barcoding 

symbologies, all MaxiCode symbols have a necessary specified size. Magnification or shrinkage 

of the symbol can cause a symbol to become unreadable, even if all elements are properly 

sized relative to each other. Magnification is not a graded parameter; however, magnification percentage will 

be reported in the general characteristics tab, along with a warning if the symbol is of a size not allowed in 

the specification. 



 

Data in MaxiCode symbols is encoded across 3 different channels, each with its own independent error 

correction budget, and each with a different intended interpretation. These three channels are referred to as 

the high priority message, and the first and second low priority messages. The error detection and correction 

information for each channel will be listed separately in the general characteristics tab.  

 

MaxiCode symbols can be encoded in any of 5 modes:  

 

Mode 2—Mode 2 is often used in the shipping industry and it uses the high priority message to store 

structured information, including a numeric postal code, a country code, and a service class. The two low 

priority channels interleave to form an accompanying message. The high priority channel uses “enhanced” 

error correction, and both low priority channels use “standard”. 

  

Mode 3— Mode 3 is often used in the shipping industry and it uses the high priority message to store 

structured information including an alphanumeric postal code, a country code, and a service class. The two 

low priority channels interleave to form an accompanying message. The high priority channel uses 

“enhanced” error correction, and both low priority channels use “standard”.  

 

Mode 4—Mode 4 uses the full data capacity (including the high priority message channel) to encode a 

message. The high priority channel uses “enhanced” error correction, and both low priority channels use 

“standard”.  

 

Mode 5—Mode 5 uses the full data capacity (including the high priority message) to encode a message. In 

mode 5, all channels use “enhanced” error correction. This means that mode 5 symbols have a greater error 

detection and correction capacity, but at the cost of a smaller data capacity compared to mode 4 symbols.  

 

Mode 6—Mode 6 symbols encode data used to reprogram reading devices. The high priority channel uses 

“enhanced” error correction, and both low priority channels use “standard”. 

 

Aztec Code is a 2D symbol with a bull’s-eye pattern at the center to locate the code. The 

orientation marks at the corners of the code allow the code to be read if rotated in any 

direction. With an Aztec Code reader, the amount of Reed-Solomon error correction is 

between 20% and 40% of the data in the code. Like other 2D Matrix symbologies, the size of 

the Aztec Code depends on the amount of data contained within the code. 

  



 

Webscan strives to provide our customers with the best available service and support in the industry. Our knowledgeable 

bar code experts are available to assist you with interpretations of verification results and use of the product or software 

features.    

 

If you need service for your TruCheck™ system, please call Webscan Technical Support at (303) 485-6811. 

Please be near the TruCheck™ system when you call and have your calibration card available. You may be 

instructed by Webscan to calibrate the system or to go into the “Advanced” menu in an effort to find and/or 

fix the problem. If factory service is required for the system, you will be given an RMA # (Return Material 

Authorization Number) that Webscan will use to track and record service activity.  

 

You do not need to ship your power supply unless instructed. Please reference your RMA number on your 

PO and shipping documents. You can apply for an RMA number on our website, under the resources tab.  

 

The address to send equipment to is:  

 

Webscan Inc.  

Attn: RMA#_______ (put in your assigned RMA#)  

1341 Sherman Drive Unit D Longmont, CO 80501 

Tel (303) 485-6811  

 

 

If you are having trouble with your Webscan system, please check a few basic things.  

 

1. Turn the system off, then on. See if this corrects the problem.  

2. Make sure the system is not in Negative Mode, unless you are in fact trying to verify a Negative.  

3. Calibrate the unit. After calibration, verify the calibration barcode. See if the values given by the system 

match the values for the calibration card.  

4. Make sure the Red Cross on your monitor is located within the Data Matrix symbol.  

5. If you are not getting the LED’s to illuminate, be sure the power brick is connected well to the power cable.  

If these actions do not correct the problem, please call Webscan Technical support as described below. 

Phone: 877.WEBSCAN or 303.485.6811  Email: support@webscaninc.com  

NOTE: It is often helpful to save diagnostic information using the “Debug Information” feature in the “Help” 

menu for email to support@webscaninc.com. 
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Webscan, Inc. warrants that all materials, workmanship, and equipment will be free of defects and will function properly 

for a period of one (1) year from the date of the Warranty Issue Date under normal and proper installation, start-up, and 

use in accordance with Webscan’s instructions and user manual.  

Webscan agrees to repair, or at its option, to replace, modify, or refund the purchase price of the equipment, if proved 

to be defective in material or workmanship during the warranty period, provided that Buyer gives Seller prompt notice of 

such defect and returns the defective item to Seller, shipping charges prepaid. Seller shall not be liable for any damage 

resulting from improper operation, inadequate maintenance, repairs, modification, or changes made by Buyer without 

Seller’s consent.  

NO CONSEQUENTIAL DAMAGES. WEBSCAN, INC. IS NOT RESPONSIBLE FOR ECONOMIC LOSS; PROFIT LOSS; OR 

SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES, INCLUDING WITHOUT LIMITATION, LOSSES OR DAMAGES 

ARISING FROM RELIANCE ON THE PRODUCT AND ITS REPORTED MEASUREMENTS EVEN IN THE EVENT OF PRODUCT 

FAILURE FOR ANY REASON.  

WARRANTY IS NOT TRANSFERABLE. THIS WARRANTY IS NOT ASSIGNABLE AND APPLIES ONLY IN FAVOR OF THE 

ORIGINAL PURCHASER/USER TO WHOM DELIVERED. ANY SUCH ASSIGNMENT OR TRANSFER SHALL VOID THE 

WARRANTIES HEREIN MADE AND SHALL VOID ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY 

OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  

IMPROPER USAGE. WEBSCAN, INC. ASSUMES NO LIABILITY FOR PARTS OR LABOR COVERAGE FOR COMPONENT 

FAILURE OR OTHER DAMAGES RESULTING FROM IMPROPER USAGE, INSTALLATION, OR FAILURE TO MAINTAIN 

PRODUCT AS SET FORTH IN THE USER MANUAL OR OTHER INSTRUCTIONS. 

IMPROPER ELECTRICAL CONNECTIONS. WEBSCAN, INC. IS NOT RESPONSIBLE FOR THE REPAIR OR REPLACEMENT OF 

FAILED OR DAMAGED COMPONENTS RESULTING FROM ELECTRICAL POWER FAILURE, THE USE OF EXTENSION 

CORDS, LOW VOLTAGE, OR VOLTAGE DROPS TO THE UNIT. 

NO IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE: THERE ARE NO OTHER 

WARRANTIES, EXPRESSED, IMPLIED OR STATUTORY, EXCEPT THE ONE (1) YEAR PARTS & LABOR AS DESCRIBED 

ABOVE. THESE WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, INCLUDING IMPLIED 

WARRANTY AND MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. THERE ARE NO WARRANTIES WHICH 

EXTEND BEYOND THE DESCRIPTION ON THE FACE HEREOF. 

 

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this 

device may not cause harmful interference, and (2) this device must accept any interference received, 

including interference that may cause undesired operation.  

  



 

Calibration Cards expire after 2 years from the date of issue. Calibration is important for industry standard 

compliance. If your calibration card is expired, contact Webscan for purchasing information. 

 

NOTE: If you have a 2D verifiers (such as a TruCheck Optima or TruCheck Omni), you can choose either a “2D 

Calibration Card” or a “Linear Calibration Card”. Either of them will allow you to calibrate the reflectance levels 

which is what calibration does. Importantly, calibration is not specific to the symbology and once the verifier is 

calibrated using either type of calibration target, the verifier is calibrated for both 1D and 2D barcodes. 

However, for 1D verifiers, such as TruCheck Laser USB which do not work on 2D barcodes, only a “1D 

Calibration barcode” can be used. 

The Webscan calibration card (part number 5136) contains both types of 

calibration target symbols and can be used to calibrate either 1D or 2D 

verifiers. The calibration target symbols on the Webscan Calibration Card 

are “Master” Symbols, similar to the master symbols on the GS1 UPC/EAN 

Card and GS1 Data Matrix Card. However, this card contains Master Grade 

Symbols only and does not contain intentionally produced “Conformance 

Test Symbols” with low grades. Meaning the Webscan calibration card can 

be used to calibrate and check your calibration values (Rmax and Rmin). 

Besides Calibration, many of the calibration target cards below can also be 

used for “Conformance Testing”.  Conformance Test Symbols are barcodes 

produced with intentional defects that give lower than perfect grades. The GS1 

Data Matrix calibration card contains Data Matrix symbols with intentional 

imperfections that you can measure with the verifier to check the reporting 

capabilities of the verifier and to document conformance to industry standards 

such as ISO/IEC 15415 and ISO/IEC 15426-2 and GS1 specifications. The GS1 

UPC/EAN Card contains UPC/EAN symbols that contain intentional 

imperfections that you can measure with the verifier to check the reporting 

capabilities of the verifier and to document conformance to industry standards 

such as ISO/IEC 15416. 

Other industry standard calibration cards with linear (1D) barcode conformance tests are available. Call 

Webscan for more information, 303.485.6811 
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The Webscan Barcode Seminar is a comprehensive learning course in barcode technology aimed at packaging 

engineers, graphics artists, and other professionals involved in the production of barcoded packaging. Whether 

you are new to barcoding or have been involved for years, if you want to truly understand the inner workings 

of barcodes, especially the newer symbologies such as GS1 DataBar (formerly RSS14), Data Matrix, Composite 

Symbology, and PDF 417, this seminar is for you! 

Taking you from the most basic concepts of barcode technology all the way through to the most advanced 

topics such as the actual methods used to scan, decode, and verify all types of barcodes, you will become an 

expert and a resource to your company. 

The course is broken into two main parts. The first, Basic Concepts, begins by introducing the basic elements 

that barcodes are composed of. A vocabulary of barcode terms is developed as the course progresses. The 

fundamental methodology used to verify barcodes is explained in detail. Also, the structure of common barcode 

symbologies such as Code 39, Interleaved 2 of 5, and Code 128 is explained in detail, including the mathematical 

methods used to decode them. The UPC or Universal Product Code is also fully explained along with several 

variations of the basic UPC symbology such as UPC-E, EAN-13 and EAN-8. The use of special encodation such 

as GS1/UCC/EAN-128 with Function 1 characters and Application Identifiers (AI’s) is also described. 

The second part of the course consists of advanced topics such as new 2D symbologies. The new GS1 DataBar 

and GS1 Composite Symbology family is explained fully, from the goals it seeks to achieve to the various formats 

allowed. Each of the GS1 DataBar formats, such as GS1 DataBar Limited, GS1 DataBar Stacked, GS1 DataBar with 

Composite, and many others are fully described, including character structure, check digit calculations, and 

data content. Data Matrix (ECC200) and PDF 417 are also fully described including structure, decoding methods 

and quality verification. The quality verification described follows the ISO15415 specification. 

Attendees will come away from this seminar with an understanding of the relationships between symbologies 

and the benefits of different symbologies as well as the challenges presented by each symbology to those 

involved in producing or scanning the codes. Attendees will be able to decipher truth from fiction in the 

marketing claims of vendors when in the process of evaluating products and be able to troubleshoot problems 

with barcode printing or scanning systems after implementation. The seminar can be customized to focus more 

on certain topics of special interest to the intended audience and less on other topics. 

This seminar is not about the end use of barcodes such as in retail settings or warehouses. Although it is about 

the core technology of barcodes used in these settings, this course does not go beyond printing and reading 

the barcodes. This is also not about how to use any specific hardware or software. 

For information about arranging for the Webscan Barcode Seminar to be presented at your company, including 

pricing, please contact Webscan toll free at 877-WEBSCAN. 

 

 

 



 

 

Webscan Validation Overview & Objective  

 

Pharmaceutical and medical device manufacturers are very concerned about quality in the manufacturing and 

packaging of their products as part of their public health responsibilities. FDA regulations and guidance in 

addition to internal quality and professionalism standards drive part of the concern. Webscan fully supports 

our customers in their quest for best achievable quality in manufacturing practices.  

The FDA has issued many documents offering guidance on computer software validation principles generally 

directed to medical devices. More specifically "General Principles of Software Validation; Final Guidance for 

Industry and FDA Staff' was issued on January 11, 2002. It is Webscan’s goal to be fully compliant with FDA 

guidance on validation principles.  

The Webscan validation protocol is designed to help ensure the highest quality standards are being met and 

follows the previously mentioned guidance. This validation protocol is expected to be used in combination 

with the customer's own quality systems to assure themselves and FDA inspectors that their manufacturing 

practices meet quality and health standards. Please contact Webscan for more information if Validation 

applies to you. 

 

  



 


